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RINGKASAN

PENGARUH PELATIHAN
PENGGUNAAN PROGRAM MICROSOFT POWERPOINT TERHADAP
KEMAMPUAN GURU (SEBAGAI O{/1P{/1), SERTA PERHATIAN SISWA
KELAS VI (SEBAGA! OUTCOME) DALAM PROSES PEMBELAJARAN
DI SMP KRISTEN PETRA 5 SURABAYA

WIDDY ENDRAYANTO

Selama ini SMP Kristen Petra 5 belum mengoptimalkan pembelajaran
secara multimodal. Padahal pembelajaran multimodal memungkinkan siswa
menerima informasi [ebih dari satu bentuk modalitas, baik berupa teks, narasi,
animasi, ilustrasi, maupun model visual. Pembelajaran multimodal membuat
perhatian siswa lebith meningkat melalui interaksi secara kognitif dengan model
visual seperti multimedia, hipermedia, maupun robot simulator. Melalui
penggunaan program komputer maka guru memiliki kesempatan untuk
meningkatkan kemampuannya sebagai desainer pembelajaran.

Tujuan penelitian 1ni menganalisis pengaruh pelatihan penggunaan
program Microsofi PowerPoint terhadap kemampuan guru dalam meningkatkan
perhatian siswa kelas VIII SMP Kristen Petra 5 Surabaya. Selain itu penelitian ini
juga menganalisis objek perhatian dan subjek perhatian.

Rancangan penelitian adalah pra eksperimental yaitu penelitian yang
mencarl hubungan sebab akibat dari suatu gejala atau kejadian yang ada.

Sampel penelitian ini adalah 10 guru dan 262 siswa kelas VIIi. Kesepuluh
guru tersebut terdiri dan guru tetap maupun guru tidak tetap. Sampel siswa

merupakan populasi siswa kelas VIII.
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Varabel independennya adalah kemampuan gura scbelum diberr pelatihan
penggunaan program Microsoft PowerPoint. Kemampuan meliputi ranah kognitif,
afektif, dan psikomotorik. Sedangkan variabel dependennya adalah kemampuan
guru setelah diber pelatihan penggunaan program Microsoft PowerPoint.

Teknik analisis yang dipakai adalah upi t berpasangan, dengan tingkat
signifikansi (a } = 0,05. Analisis tersebut berdasar hasil alat pengolah data yaitu
program Aficrosoft I-xeef dan program SPSS versi 14,0,

Hasil penelittan menunjukkan bahwa, pertama pelatthan penggunaan
program Aficrosoft PowerPoine mempengaruhi kemampuan baik kognitif, afektif,
maupun psikomotorik guru dalam proses pembelajaran. Kedua, penggunaan
program Microsofi PowcerPomt dalam  proses pembelajaran  mempengaruhi
perhatian siswa. Selain itu. hasil penelitian menunjukkan bahwa salah satu dari
keempat aspek objek perhatian mendapat penilaian lebih baik dari populasi siswa.

Sedang untuk keempal aspek subjek perhatian mendapat penilaian yang sama dari

populasi siswa.

Manfaat dar penelitian yaitu dapat memberi kontribusi berupa hasil
penerapan tlmu di Program Pengembangan Sumber Daya Manusia Pasca Sarjana
Universitas Airlangga Surabaya. Secara praktis hasil penelitian ini dapat
diimplementasikan di hingkungan SMP Kristen Petra 5 dan yang berimplikasi
dengan PPPK Petra Surabaya dalam mengambil kebijakan.

Keterbatasan penefitian 11 adalah: pertama, tidak ada kelompok kontrol.
Kedua, waktu yang tersedia untuk pelatihan hanya 2 kali pertemuan, sehingga
dimungkinkan kurang opumalnya guru dalam persiapan PBM menggunakan

program Microsoft PowerPoint. Ketiga, tidak semua aspek perhatian diolah secara

vili
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crosstab, melainkan hanya beberapa aspek perhatian saja yang dipandang cukup
mewakili dari segi karakteristiknya.

Dengan demikian dapat disimpulkan bahwa terbukti ada peningkatan
kemampuan guru dalam proses pembelajaran serta ada peningkatan perhatian

siswa kelas VIII dalam proses pembelajaran di SMP Kristen Petra 5 Surabaya.
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SUMMARY

THE EFFECT OF MICROSOI'T POWERPOINT TRAINING PROGRAM
TOWARD THE CAPABILITY OF THE TEACHERS (AS AN QUTPUT), AND
THE ATTENTION OF THE GRADE VIII STUDENTS (AS AN OUTCOME) IN

LEARNING PROCESS IN PETRA 5 CHRISTIAN JUNIOR HIGH SCHOOL
SURABAYA

WIDDY ENDRAYANTO

Petra 5 Christian Junior High School has not optimized the multimodal
learning so far. The multimodal learning enables students to receive information
using more than one type of modality, such as texis, narratives, animations,
{liustrations, and visual models. The multimodal learning enhances the attention
of students through a cognitive interaction with visual models such as multimedia,
hypermedia, or robot simulator. By using computer programs, teachers have the
opportunity to enhance his/her capability as learning designers.

The objective of this research is to analyze the effect of the Microsofi
PowerPoint training programs toward the capability of the teachers in enhancing
attention of the grade VI students in Petra 5 Christian Jumor High School. This
research also analyzes the object and the subject of attention.

The research methodology i1s pre-experimental which is a research seeking
the causal relationship of a phenomenon or an event.

The samples of this research are 10 teachers and 262 grade VIII students.
Those ten teachers are permanent as well as temporary ones. The samples of the
students are the population of grade VIII students.

The independent variable is the capability of the teachers before attending
the Microsoft PowerPoint traiming program. The capability includes the cognitive,
affective, and psychomotor domains. And the dependent variable is the capability
of the teachers after attending the Microsoft PowerPoint training program,

The analysis technique used is the paired t test, with significance level (a)
= 0.05. This analysis 1s based on the result of the data processing instruments
namely Micrasofi lxcel program and SPSS program version 14.0,

Firstly, the result of this research reveals that the Microsoft PowerPoint
training program iniluences the cognitive, aflective, or psychomotor capabilities
of the teachers in the learning process. Secondly, the application of Microsoft
PowerPoint program in learning process influences the attention of the students.
The result of this research also reveals that one of the four aspects of the attention
objects gets a better assessment {from the student population. While the four
aspects of the attention subjects get an equal assessment from the student
population.

The advantage of this research is to contribute an application of science in
the Post Graduate Program of Human Resources Development in Universitas
Airlangga Surabaya. Practically the result of this research can be implemented in
Petra S Christian Jumor Hiph School and implicitly influence the PPPK Petra
Surabaya in making a policy.
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The limitations of this research are: first, there is no control group. Second,
the time available for training is only 2 meetings, so there is a possibility that
teachers did not prepare the PBM using Microsofi PowerPoint program optimally,
Third, not all observation aspects are processed using crosstab, only some aspects
which are considered characteristically representative enough.

Conclusively, it is proven that there is an enhancement in the capability of
the teachers in the learning process and there is an enhancement in the attention of

the grade VIII students in the learning process in Petra § Christian Junior High
School Surabaya.

XI
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ABSTRACT

THE EFFECT OF THE MICROSOFT POWERPOINT TRAINING PROGRAM
TOWARD THE CAPABILITY OF THE TEACHERS (AS AN QUTPUT), AND
THE ATTENTION OF THE GRADE VIII STUDENTS (AS AN QUTCOME) IN

LEARNING PROCESS IN PETRA 5 CHRISTIAN JUNIOR HIGH SCHOOL

SURABAYA

WIDDY ENDRAYANTO

This research aims to analyze the effect of the Microsofi PowerPoint
training program toward the capability of teachers in enhancing the attention of
the grade VIII students in Petra 5 Christian Junior High School. This research also
analyzes the object and the subject of attention.

The samples of this research are 10 teachers and 262 grade VIII students.

The research methodology used is pre-experimental using paired t test
analysis techmic with significance level (a) = 0,05

This research shows that the Microsofi Powerpoint training program
influences the cognitive, affective, or psychomotor capability of the teachers in
the leaming process. While the use of Microsofi Powerpoint program in the
learning process influences the attention of the students. The result also reveals
that one of the four aspects of the attention objects gets a better assessment from
the student population. And the four aspects of the attention subjects get an equal
assessment from the student population. This research recommends that teachers
should train themselves in order to enhance their capability. Afterwards advance
traiming can then be offered to the teachers. If the stages are not arranged like that
then there will be many disadvantages.

The limitations of this research are the absence of control group, the
infrequency of training, and not all aspects of attention are processed using
Ccrosstab.

Key words: training, cognitive, affective, psychomotor, capability, attention.
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BAE |

PENDAHULUAN

I.1 Latar Belakang Penelitian

Kemampuan guru baik dalam pemahaman, sikap dan ketrampilan
dalam pembelajaran selama ini  sebagian besar masih menggunakan
pendekatan tradisional yaitu menggunakan media instruksional secara
monomodal yakni siswa menerima informasi yang disajikan hanya satu
bentuk modalitas. lal demikian kurang membantu siswa dalam memahami
suatu penjelasan. Pada sisi yang lain pembelajaran secara multimodal, siswa
menerima informasi lebih dari satu bentuk modalitas, berupa paduan antara
teks, narasi, animasi, ilustrasi, dan model visual.

Pembelajaran menggunakan multimodal ketika siswa berinteraksi
secara kognitif’ dengan model visual seperti muitimedia, hipermedia, dan
robot simulator.  Ketika siswa belajar lewat multimodal, siswa lebih
terstimulasi dan memiliki usaha belajar yang lebih tinggi (Gabe, 1997 dalam
Pranata, 2006).

Pembelajaran menggunakan muitimodal ini lebih membantu siswa
dalam memahami suatu penjelasan serta menggunakan seluruh level
kemampuan kognitifnya untuk memecahkan masalah. Hal demikian sejalan
dengan pendapat Baugh, Achsin dalam Azhar (2005), yang menyatakan
bahwa perbandingan perolehan  hasil belajar melalui indera pandang dan

indera dengar sangat menonjol perbedaunnya. Perolehan hasil  belajur

— ‘..5\‘\
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seseorang melalui indera pandang kurang lebib 90%, sedang melalui indera
dengar kurang lebih 5%, sedang kurang lebih 5 % sisanya menggunakan
indera lainnya. Namun demikian media instruksional dapat berfungs: efektif
bila diwujudkan melalui metode konstruktivistik dimana perancangan media
harus berbasiskan pembclajaran, bukan sckedar siswa dapat menyerap dan
mengingat sebanyak-banyaknya informasi  Dalam pengertian i bahwa
pembelajaran menggunakan media secara konstruktivistik adalah suatu proses
memberdayakan siswa agar siswa belajar bagaimana belajar.

Dengan  adanye  program  komputer  scbagai  teknologi  dalam
pembelajaran yang memodernisir nedia instrukstonal, maka guru dapat
menggunakan teknologi tersebut. Oleh karena itu pembelajaran menggunakan
media multimodal memiliki  keunggulan dalam  mendorong  guru
meningkatkan kemampuannya sebagai desainer pembelajaran  (Pranata,
2006). Selain itu, peran guru dalam menggunakan dan mengarahkan
penggunaan media berbasis komputer akan sangat menentukan kualitas hasil
pembelajwan bermedia, Dalam konteks demikion, selama ing pembelajaran di
SMP Kristen Petra 5 scbagian besar masih menggunakan pendekatan
tradisional, vaitu pembelajaran menggunakan media instruksional secara
monomodal. Kondisi demikian tentu tidak kondusif dan siswa belum
menjalani proses belajar yang mengoptimalkan seluruh level kemampuan
kognitifnya.

Maka upaya pemberdayaan guru agar nantinya guru memiliki
kemampuan dalam menguasai teknologi komputer sehingga dapat

menghasilkan media instruksional berbasis komputer, merupakan perhatian
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dalam pengembangan sumber dava manusia di SMPKnsten Petra 5
Surabaya. Pemberdayaan tersebut periu diwujudkan melalui pelatihan
penggunaan program komputer.

Berdasar data bulan Oktober 2005, sebanyak 27,66% guru SMP
Kristen Petra 5 Surabaya belum memiliki kemampuan menggunakan program
Microsoft PowerPome. Hal itu dapat dilihat dalwon wabel T Sedangkan
72.34% guru vyang sudah memiliki kemampuan menggunakan program
Microsoft PowerPoint belum secara optimal memantaatkan kemampuannya

tersebut dalam pembelajaran.

Tabel 1.1 Data Guiu SMPP Kosten Petia 5 Surabaya

| I PENGGUNAAN POWERPOINT
NO SEATUS GLRL (RLLE _:ill[_)r\ll HISA f”'f”:‘” TN A
R B o ML % | ML | e
| | GURU TETAP 27 25 5309 2 | 426
“ 2 | GURUTIDAK TETAP | 20 o |1o(s|[ 11 | 23,40
| JUMLAH a7 | 34 734l 13 | 2766

Sumber informasi:
Humas SMP Kristen Petra 5 Surabava

Kemungkinan kendala tersebut karena setiap kelas belum tersedia
perangkat komputer beserta LCD (Liquid Crystal Display) projector. Sedang
ruangan yang memiliki perangkat komputer beserta 1O Projector masih
sebatas satu ruang scrba guna, yang pemakaiannya harus bergantian untuk
dua puluh kelas Namun sarana dan prasarana berupa satu ruang laboratorium
komputer dengan empat puluh perangkat komputer layak pakai, telah
memadar untuk penyelenggaraan pelatihan.

Hal utama sebelum penyelenggaraan pelatihan adalah penentuan

materi program komputer manakah yang akan diberikan. Dari berbagal
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program komputer serta model visual yang ada, maka sementara ini program
Microsof PowerPoint merupakan pilihan yang cukup memadai untuk
pengadaan multimedia yang dapat digunakan sebagai media instruksional
secara multimodal. Dengan demikian, selesat pelatihan penggunaan program
Microsof  PowerfPoini,  dibarapkan secara  berangsur  pembelajaran
menggunakan media instruksional secara multimodal akan mengganti
pembelajaran secara monomodal yang kurang memberi stimulasi bagi siswa.

Media instruksional yang kurang membert stunulasi kepada siswa
memberi dampak berkurangnya perhatian siswa terhadap penyajian informasi
saat pembelagaran. Hal atu didukung Survabrata (2008), yang berpendapat
bahwa munculnya perhatian dipengaruhi oleh dua hal: objek yang memiliki
daya tank perhatian, dan subjek dengan segala hal yang dimilikinya.

Kondisi di atas terdapat berbagai permasalahan yang perlu
disclesaikan dengan mencan solusinya. Namun dalam hal ini pembatasan

terhadap suatu permasadahan dipeclukan untuk tyuan penclitian,

1.2. Rumusan Masalah Penelitian
I. Apakah pelatthan penggunaan program Aicrosofi Powerf’omt dapat
mempengaruhi kemampuan batk kognitif, afektif. mavpun psikomotorik

guru dalam proses pembelajaran?

2. Apakah  penggunaan program  Microsoft Powerf'omt dalam proses
pembelajaran dapal mempengaruhi perhatian siswa?
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1.3. Tujuan Penelitian
13.1. Tujuan Umum
Menganalisis pengaruh pelatthan penggunaan program Microsoft
PowerPoint terhadap kemampuan guru dalam meningkatkan perhatian
siswa kelas VIII SMP Kristen Petra 5 Surabaya.
1.3.2. Tujuan Khusus
1.3.2.1. Menganalisis pengaruh pelatthan  penggunaan program
Microsofi  PowerPoint terhadap kognitif, afektif, dan
psikomotorik guru dalam pembelajaran.
1.3.2.2. Menganalisis media pembelajaran menggunakan program
Microsoft PowerPoint sebagai objek perhatian.
1.3.2.3. Menganalisis aspek dalam diri siswa sebagai subjek yang
terkait dengan perhatian terhadap media pembelajaran
menggunakan program Microsoft PowerPoint.
1.3.2.4. Menganalisis pengaruh penggunaan media pembelajaran
menggunakan program Microsofi  PowerPoint  terhadap

peningkatan perhatian siswa.

| .4 . Manfaat penelitian

I. Secara teoritis penelitian ini akan memberi kontribusi hasil penerapan
ilmu di Program Pengembangan Sumber Daya Manusia Pasca Sarjana

Universitas Airlangga Surabaya.

2. Secara praktis hasil penelitian ini dapat digunakan oleh SMP Kristen

Petra 5§ Surabaya untuk mengambil kebijaksanaan.
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3AL3 2

TINJAUAN PUSTAKA

2.1. Media Pembelajaran Berbasis Komputer

Sistem informasi dirancang untuk memudahkan dalam menyusun, dan
mengelola berbagar informasi yang diperlukan. Dalam  operasionalnya,
sistem informast didukung dengan perangkat lunak berupa program-
program. Salah satu program yang ada adalah program Microsoft
PowerPaoint, yakni program yang dirancang untuk menyiapkan media
presentasi. Presentast bak datam seminar, lokakarya maupun dalam proses
belajar mengajar

Dalam pembelajaran, media presentasi sering disebut sebagai media
instruksional, seperti yang diungkapkan oleh Pranata (2006) sebagai berikut.

“Pandangan-pandangan model pembelajaran bermedia mempe-

ngaruhi bagaimana media instruksional dirancang dan digunakan

dalam pembelajaran.”

Media instruksional yang berbasis program komputer memiliki
kelebihan terutama dapat dipakai dalam pembelajaran secara multimodal.

Media pembelajaran berbasis program Microsofi PowerPoint dapat
memvisualisasikan data maupun gagasan melalui huruf, gambar, animasi,
ilustrasi, dan foto secara menarik dengan menggunakan fasilitas efek
tampilan. Huruf, gambar animasi, ilustrasi, dan foto merupakan objek yang
dapat didesain hingga menghasilkan media presentasi untuk pembelajaran

berupa  slide  yang  sunpat  menarik.  Bahkan  Microsoft PowerPomt

6
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menyediakan sarana pendukung berupa suara (audio) untuk memberikan
effect atau ilustrasi saat s/ide tersebut ditayangkan. Kenyataan ini seperti
yang diungkap oleh Arsyad Azhar (2005) sebagai berikut:

"Perkembangan ilmu pengetahuan dan teknologi semakin men-

dorong upaya-upaya pembaharuan dalam pemanfaatan hasil-
hasil teknologt dalam proses belajar.”

Sehingga Kemp & Dayton dalam Azhar (2005), berupaya
mengelompokkan media dalam delapan jenis, yaitu: media cetakan, media
pajang, overehad (transparacies, rekaman audiotape, seni slide dan

filmstrips, penyajian multi-image, rekaman video dan film hidup, dan

komputer.

”...mengelompokkan media dalam delapan jenis, yaitu :
media cetakan, media pajang, overhead transparacies,
rekaman audiotape, seri slide dan filmstrips, penyajian
multi-image, rekaman video dan film hidup, dan komputer.”
Komputer dapat merekam, menganalisis, dan memberikan reaksi
kepada respon yang di-inpwr oleh pemakai atau siswa. Komputer untuk
pendidikan dikembangkan dalam beberapa format yang dinlis dan praktis,
antara lain tutorial, simulasi, permainan, discovery serta tayangan yang
menggunakan program Microsoft Power Point.
Berikut disajikan bagaimana ciri-ciri umum tentang batasan media
pendidikan menurut Azhar Arsyad.
1. Media pendidikan memiliki pengertian fisik yang dewasa ini dikenal
sebagal perangkat keras (hardwure), vailu sesuatu benda yang dapat

dilihat atau diraba dengan panca indera.
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2. Media pendidikan memtliki pengertian nonfisik yang dikenal sebagai
perangkat lunak (soffware), yaitu kandungan pesan yang terdapat dalam
perangkat keras yang merupakan isi yang ingin disampaikan kepada siswa.

3. Penekanan media pendidikan terdapat pada visual dan audio.

4. Media pendidikan memiliki pengertian alat bantu pada proses belajar baik
di dalam maupun di luar kelas..

5o Media pendidikan digunadvan dadanm angka komumkas: dan mileraks: guiu
dan siswa dalam proses pembelajaran.

6. Media pendidikan dapat digunakan secara massal (misalnya: radio,
televis), kelompok besar dan kelompok kecil (misalnya film, sfide, video,
OHP), atau perorangan (misalnya: modul, komputer, radio fape/ kaset,
video recorder),

Memperhatikan batasan tentang suatu media pendidikan di atas, maka
salah satu fungsi utama media pembelajaran adalah sebagai alat bantu mengajar
yang turut mempengaruhi tklim, kondisi, dan lingkungan belajar yang ditata dan
diciptakan guru.

Hamalik dan Azbar (2005), mengemukakan bahwa pemakamn medim
pembelajaran dalam proses belajar mengajar (PBM) dapat membangkitkan
keinginan dan minat yang baru, membangkitkan motivasi dan rangsangan
kegiatan belajar. Bahkan membantu keefektifan proses pembelajaran dan
penyampaian pesan serta isi pelajaran, meningkatkan pemahaman, menyajikan
data dengan menarik  dan  terpercaya, memudahkan  penafSiran data dan

memadatkan informasi.
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Menurut Kemp & Dayton dalam Azhar (2005), bahwa media pembelajaran
dapat memenuhi tiga fungsi utama: 1 Memotivasi minat dan tindakan; 2.
Menyajikan informasi, dan 3. Memberi instruksi.

tncyclopedia  of  Fducational Research dalam [Tamalik dan  Azhar

menyebutkan manfaat media sebagai berikut:

1" Meletakkan dasar-dasar yang konkret untuk berpikir, oleh karena itu
mengurangi verbalisme.

2. Memperbesar perhatian siswa.

3. Meletakkan dasar-dasar yang penting untuk perkembangan belajar, oleh karena
itu membuat pelajaran lebih mantap.

4. Memberikan pengalaman nyata yang dapat menumbuhkan kegiatan berusaha
sendiri di kalangan siswa.

5. Menumbuhkan pemikiran yang teratur dan kontinyu, terutama melalui gambar
hidup.

6. Membantu tumbuhnya pengertian dan perkembangan kemampuan berbahasa.

7. Memberikan pengalaman vang tidak mudah diperoleh dengan cara lain, dan

membantu efisiensi dan keragaman yang lebth banyak dalam belajar.

Levie & Levie dalam Azhar (1975), menyimpulkan bahwa stimulus visual
membuahkan hasil belajar vang lebih baik untuk tugas-tugas seperti mengingat,
mengenall, mengingat kembali, dan menghubung-hubungkan fakta dan konsep.
Sedangkan Paivio dalam Azhar (1975), memiliki konsep dual coding hypothesis
(hipotesis koding ganda), yang menyatakan bahwa ada dua sistem ingatan

manusia. Satu untuk mengolah simbol-simbol verbal kemudian menyimpannya

dalam bentuk proposisi image, dan yang lainnya untuk mengolah image nonverbal
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vang kemudian disimpan daiam bentuk proposisi verbal.

Yunus dalam Azhar (2005), menyebutkan bahwa orang yang
mendengarkan saja tidaklah sama tingkat pemahaman dan lamanya pemahaman
bertahan. Apa yang dipahaminya oleh mereka yang melihat saja, akan kalah jauh
dibandingkan dengan mereka yang melihat dan sekaligus mendengarkan.

Lebih rinci lagi dari Yunus, Baugh dalam Achsin dalam Azhar (2005),
menyatakan bahwa:

“Perbandingan pemerolehan hasil belajar melalui indera pandang

dan indera dengar sangat menonjol perbedaannya. Pemerolehan hasil

belajar seseorang melalui indera pandang kurang lebih 90%, sedang

melalui indera dengar kurang lebih 5%, sedang kurang lebih 5% sisa-

nya menggunakan indera lainnya.”

Levie & Lentz dalam Azhar (2005), menyebutkan bahwa fungsi
pembelajaran, khususnya media visual, ada 4 yaitu:

1. Fungsi Atensi. Media menarik dan mengarahkan perhatian siswa untuk
berkonsentrast kepada isi pelajaran. Bahkan media digunakan pada awal
pelajaran untuk menarik perhatian awal.

2. Fungsi Afektif. Gambar atau lambang visual dapat menggugah emosi dan
sikap siswa, misalnya informasi yang menyangkut masalah sosial.

3. Fungsi Kognitif. Gambar atau lambang visual memperlancar pencapaian
tujuan untuk memahami dan mengingat informasi atau pesan yang
terkandung dalam gambar.

4. Fungsi Kompensatoris. Media visual memberikan konteks untuk memahami
teks, membantu siswa yang iemah dan lambat dalam memahami isi pelajaran

yang disampaikan dengan teks atau disajikan secara verbal.
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Berikut keuntungan komputer terkait dengan media pembelajaran:

I. Memberikan iklim yang bersifat afektif dengan cara vang lebih individual,
tidak lupa, tidak bosan, sabar dalam menjalankan instruksi.

2. Merangsang siswa mengerjakan latthan, melakukan kegiatan laboratorium
atau simulasi karena tersedianya animasi grafik, warna, dan musik yang
dapat menambah realisme.

3. Menyesuaikan dengan tingkat penguasaaan siswa dalam menggunakannya.

4. Memantau perkembangan pembelajaran siswa karena memiliki fungsi
merckanm.

5. Dapat mengendalikan peralatan lain seperti compuc disc, video tupe, dan
lain-lain.

6. Dengan bantuan LCD projector, dapat ditayangkan pesan-pesan ke layar

lebar untuk dilihat oleh beberapa orang dalam kelompok atau kelas.
2.2. Pelatihan
Nadler dun Nadlee (1987), mengatakan bahwa.

“Ielatihun merupakan pembelujnan yang discdinkun pengusa-
ha kepada pekerja berkaitan dengan pekerjaan mereka saat ini.”

Sedangkan Tall & Hall (1998), memiliki kesimpulan bahwa:

“Dengan menghombinasikan berbagai macam faktor seperti
teknik pelatihan yang benar, persiapan dan perencanaan
yang matung, serta komiimen terhadap esensi polatihan,

organtannt dnpnt mencapni keberlinmilan dalam porsnimgnn
pasar yang sangat ketat,”
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Adapun Sofo (1999), menvatakan bahwa:

“Pelatthan dalam format apapun masih dibutuhkan,
karena memberikan inspirasi dan bersifat transformatif.”

Lebih lanjut Sofo menyatakan bahwa pelatthan muncul dalam siklus
pembelajaran yang dimulai dan kesadaran. Melalui kesadaran nilah pelatih
membantu klien untuk memperjelas apa yang benar-benar diinginkan klien.
Dan Mathis Robert L., Jackson John H_, (2001), menyatakan bahwa:

“Pelatihan kerja-ketrampilan (job-skil! training) adalah bagian
dari pelatihan dan pengembangan Sumber Daya Manusia

(SDM). Pelatihan berkesinambungan diperlukan untuk

tanggap terhadap perubahan teknologi. Hal itu berkenaan
dengan pengembangan semua tenaga kerja dimana diperlukan
untuk menyiapkan organisasi menghadapi tantangan ke depan.”

Soekidjo Notoatmodjo (2003), menyatakan bahwa:

"Kemampuan sumber daya manusia harus terus menerus
ditingkatkan seirama dengan kemajuan dan perkembangan
organtsasi.”
Menurutnya bahwa siklus pendidikan dan pelatihan secara garis besar
meliputi:
1. Anahlisis Kebutuhan Pendidikan dan Pelatihan, Dalam tahap ini terdapat
analisis organisasi, analisis pekerjaan, dan analisis pribadi.
2. Menetapkan Twuan. Tujuannya adalah adanya perubahan pernlaku

(kemampuan). Maka perumusan tujuan harus dalam bentuk tingkah laku

(behavior objectives).

3. Pengembangan Kurikulum. Upaya menyediakan materi dan metode belajar

i v L
ORI
e ————————
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mengajar yang sesuan dengan kebutuhan.

4. Persiapan Pelaksanaan Diklat, Kegiatan persiapan meliputi kegiatan
administrasi.

5. Pelaksanaan Pendidikan dan Latihan. Pelaksanaan yang terus dimonitor
oleh penanggung jawab hanian,

6. Evaluasi Kegiatan. Evaluasi terhadap proses dan hasil kegiatan sejauh

mana pendidikan dan pelatihan dikuasasi peserta.

Pada bagian yang lain Syarif Rusli (1991), menyatakan bahwa:
"Kebutuhan latihan adalah selisih antara sikap dan
ketrampilan yang diminta dengan sikap dan ketrampilan
yang tefah dimiliki, atau selisth antara prestasi yang
diminta dengan prestasi yang telah dicapai.”
2.3. Hasil Belajar
Menurut  Bloom, beberapa indikator dan kemungkinan cara

mengungkapkan hasil pembelajaran dalam kawasan (ferm); kognitif, afektif,

dan psikomotor adalah seperti dalam tabel 2.1

Tabel 2.1 Hasil Belajar Menurut Bloom

JENIS HASIL CARA
BELAJAR INDIKATOR PENGUKURAN
A KOGNITIF |
Pengamatan/ Dapat menunjukkan/ { Tugas/ tes/ observasi
perseptual membandingkan/ menghu-
bungkan
Hafalan/ ingatan Dapat menyebutkan/ Pertanyaan/ tugas/ tes
i Menunjukkan lagi
Pengertian/ ‘ Dapat menjelaskan/ Pertanyaan/ persoalan/
' pemahaman i Mende-finisikan dengan tes/ tugas

i ‘ kata-kata sendiri.
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Program/
penggunaanan

Alisis

Sintesis

Evaluasi

B. AFEKTIF
Penerimaan
Sambutan

Penghargaan/
apresiasi

Internalisasi/
pendataman
Karakterisasi/

penghayatan

i C. PSIKOMOTOR
Ketrampilan

. bergerak/ bertindak.

| Ketrampilan

" ekspresi verbal dan

- non verbal

| Dapat memberikan contoh/
| menggunakan dengan
: tepat/ memecahkan
masalah
Dapat menguraikan/
mengklasifikasikan
Dapat menghubungkan/
| menylmpulkan/  mengge-
i neralisasikan
Dapat menginterpretasikan/
i memberikan kritik/
membertkan pertimbangan/
penilaian

Bersikap menerima/
Menyetujui atau sebaliknya
Bersedia terlibat/
partisipasi/ memanfaaikan
atau sebaliknya.
Memandang penting/
bernilai/ berfaedah/ indah/
harmoms/ kagum atau
sebaliknya

Mengakui/ mempercayai/
meyakinkan atau  scbalik-
nya

Melembagakan/ membiasa-
kan/menjelmakan dalam
pribadi  dan  perilakunya
schari-hart

Tugas/ persoalan/ tes

Tugas/ persoalan/ tes

' Tugas/ persoalan/ tes

Tugas/ persoalan/ tes

Pertanyaan/ tes/ skala
sikap
Tugas/ observasi/ tes

Skala penilaian/ tugas/
observasi

Skala  sikap/ tugas
ckspresiff proyekuf

Observasi/ tugas
ekspresi/ proyektif

1 —

Koordinasi
dan kaki
Gerak, mimik, ucapan

mata, tangan

Tugas/ observasi/ tes/
tindakan
Tugas/ observasi/ tes/
tindakan

Sedangkan menurut Horward Kingsley dan Gagne dalam Sudjana,

bahwa:

”Hasil belajar sebagai objek penilaian dimana ada tiga
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macam hasi| belajar, meliputi: ketrampilan dan
kebiasaan: pengetahuan dan pengertian; sikap dan
cita-cita. Dan luna kategori hasil belajar: informasi
verbal, ketrampilan intelektual, strategi kognmitif, sikap,
dan ketrampilan motoris,”
Menurut Gagne paling sedikit ada lima macam perubahan perlaku
akibat pengalaman antara lain:
1. Belajar responden. Perubahan perilaku akibat perpasangan antara
stimulus tak terkondist dengan stimulus terkondisi.

2. Belajar kontiguitas, Perubahan perilaku karena dua peristiwa

dipasangkan satu dengan yang lain dalam suatu waktu.

"

Belajar operant. Perubahan penlaku disebabkan oleh konsekuensi-

konsekuensi perilaku.

4. Belyjar observasional. Perubahan perilaku karena hasil kegiatan
observasi dan kejadian-kejadian,

5. Belajar kognitif. Perubahan pertlaku karena melihat dan memahami

peristiwa-peristiwa. Dengan insight manusia belajar menyelami

pengertiun,

2.4, Perhatian

Menurut Suryabrata (2005), bahwa:

“Hal-hal yang dapat mempengaruhi adanya suatu perhatian
ada dua. Pertama, objek yang menjadi perhatian. Kedua,
subjek yang memperhatikan.”

a. Perhatian dipandang dari segi objek.

Hal yang menarik perhatian adalah hal yang keluar dari konteksnya
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wlan dongan hati lan, hal yang menank adalah hal yang lain dari pada
yang lain.

Hal yang lain tersebut bisa timbul dari hal sebagai berikut-

- Wamna. Warna dominan di sekitar warmna vanp hampir samn akon
terkesan lebih menyita perhatian daripada warna lajn yang hampir

i

I

. Gerakan. Gerakan vrang yang mondar mandir di sekitar orang yang

duduk dengan lenang, akan tampak lebth menuntut perhatian daripada

orang yang duduk dengan tenang.

3. Cahaya. Lampu yang menyala secara berkedip di antara lampu lain
yang menyala secara tetap akan lebih dominan dalam menyedot
perhatian daripada lampu yang menyala secara tetap.

4. Susunan. Tulisan dalam iklan yang tertulis secara terbalik akan lebih
meminta perhatian daripada tulisan yang ditulis seperti biasanya,

5. Kebiasaan. Keadaan, sikap, sifat, cara berpakaian yang lain dari
biasanya akan lebih menarik perhatian.

6. Kejadian tiba-tiba. Hal yang sifatnya mendadak datang dan lenyapnya

akan lebith menarik perhatian.

b. Perhatian dipandang dari segi subjek yang memperhatikan,
Hal yang menarik adalah hai yang sangat bersangkut paut dengan
pribadi subjek. Hal yang bersangkut paut dengan subjek antara lain:
I. Kebutuhan. Conioh, obat merupakan kebutuhan bagi orang yang sakit.
Informasi tentang perumahan merupakan kebutuhan bag; yang mau

membeli rumah.
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2. Kegemaran, Bulu tangkis merupakan cabang olah raga yang digemari
bagi orang yang gemar dengan olah raga tersebut. Wayang merupakan
sem pertunjukkan tradisional yang digeman bagi yang suka dengan
kesenian tersebut.

3. Pekerjaan atau keahlian. Berita tentang penemuan benda kuno akan

diminati bagi ahli sejarah. Pelatihan kesehatan akan lebih diperhatikan

oleh perawat.
4. Sejarah hidup sendiri. Berita tentang UGM akan diminati oleh alumni

UGM. Berita tentang Surabaya akan diminati oleh arek-arek Surabaya.

Aktivitas yang melibatkan perhatian secara intensif akan lebih
sukses dalam meningkatkan prestasi Sedangkan perhatian secara sponfan
akan lebih lama pengaruhnya daripada perhatian sengaja  dalam
meningkatkan prestasi. Dan uraian di atas dapat digambarkan kerangka

teoritisnya sebagai berikut:

N

PROCESS ouTPUT OUTCOME

KEMAMPUAN

PEMBELAJARAN PERHATIAN
GLURQYy SISWA

Gambar 2.1. Kerangka Teoritis dari Tinjauan Pustaka
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BAB 3
KERANGKA KONSEPTUAL

DAN
HIPOTESIS PENELITIAN

3.1 Kerangka Konseptual

Kerangka konseptual penelitian ini adalah sebagai berikut:

PELATIHAN L KEMAMPUAN

GURU
’ «1Q,ELSI <

I +BAKAT |
\  *MINAT !
\_ *PENDIDIKAN ,

d -
e -

KETERANGAN:
Vaciabel yang Diteliti
............. - Variabe! Luar vang Tidak Ditelti

Gambar 3.1. Kerangka Konseptual Penelitian

Kerangka konseptual di atas dijelaskan scbagai berikut. Pefatihan
dapat meningkatkan kemampuan. Demikian pula 1Q (nielligence (Quotient),
El (Emotional [nielligent), S1 (Spiritual Intelligence) serta bakat, minat, dan
pendidikan, berperan pula dalam meningkatkan kemampuan seseorang.

Dalam hal 11 penelitan akan memfokuskan pada pelatthan.

Sedangkan 1Q (Jntelligence Quotient), El (Emotional Inielligent), Sl

18

TESIS PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO




IR-PERPUSTAKAAN UNIVERSITAS AIRLANGGA

19

(Spiritual Intelligence), bakat, minat, dan pendidikan udak diteliti.
Dimungkinkan, bahwa dari hasil pelatihan, guru akan menghasilkan
outcome berupa meningkatnya perhatian siswa dalam mengikuti

pembelajaran dengan menggunakan MPP.

3.2 Hipotesis Penelitian

1. Pelatihan penggunaan program Microsofi PowerPoint mempengaruhi
kemampuan baik kognitif, afektif, maupun psikomotorik guru dalam
proses pembelajaran.

2. Penggunaan program Microsoft PowerPoint dalam proses pembelajaran

mempengaruhi perhatian siswa kelas VIII.
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BAB 4.

MATERI DAN METODE PENELITIAN

4.1. Rancangan Penelitian yang Digunakan
Rancangan penelitian ini adalah pra eksperimental yaitu kegiatan
penelitian yang mencari  hubungan sebab akibat dan suatu gejala atau
kejadian yang ada. Penelitian untuk menemukan penjelasan bagaimana

pelatihan penggunaan program Microsofi  PowerPoint dapat meningkatkan

kemampuan guru dafam proses belajar mengajar. Sclanjutnya, penelitian
observasi juga digunakan untuk memberi gambaran tentang peningkatan
perhatian siswa vang telah mengikuti pembelajaran yang menggunakan
media instruksional berbasis program Micrasoft Powerfoint

Penelitian pra eksperimental ini menggunakan dua tahap kegiatan.
Tahap pertama, pembuatan modul tentang penggunaan program Microsoff
Penverf? o dalam proses pembelaguian. Maten modul disusun dat
beberapa buku sumber yang berisi tentang Microsofi PowerPoint serta hasil
diskust dengan 2 instruktur dari Bina Satya Wacana. Materi yang terkumpul
dikemas disesuaikan dengan kebutuhan proses pembelajaran serta
memperhatikan kondisi peserta pelatihan. Modul memuat teori serta lembar
kerja pembuatan sfide menggunakan Microsofi PowerPoint. Selain modul,
dibuat pula perangkat prefest dan posttest tentang program Microsofi
PowerPoint.

Pada tahap kedua ini ada tiga sesi kegiatan. Sesi pertama, guru

diberi pretest tentang propram  AMicrosofi PewerPoint. [lal ini untuk

20
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mengetahul kemampuan awal sebelum guru diben pelatihan. Sesi kedua,
guru diberi perlakuan berupa pelatihan tentang penggunaan program
Microsoft PowerPoint. Kegiatan imi dilaksanakan dua kali pertemuan yang
masig-masing pertemunn selama 90 meanit, bortempat di Taboratoriom
komputer sekolah. Sesi keliga, guru diberi posttest tentang program
Microsoft  PowerPoint. Materi posttest diberikan setelah guru mengikut
pelatthan. Materi posttest isinya sama dengan materi prefest.

Hasil posttest akan dibandingkan dengan hasil pretest. Kegiatan
membandingkan dilakukan untuk mengetahui perkembangan kemampuan
guru setelah diberi pelatihan (owtpur). Tahap selanjutnya, dilakukan
kegiatan untuk mengetahui pengaruh kemampuan guru dalam menggunakan
MPP terhadap perhatian siswa (outcome).

Kegiatan tersebut dirancang sebagai berikut. Dari ketiga belas guru
yang mengikuti pelatihan akan diambil satu guru vang memperoleh hasil
penilaian terbaik, Selanjutnya guru yang terpilih tersebut diberi kesempatan
meluksanakan pembeligman sesuat bidang studi yung diajatkan dengan
menggunakan media instruksional berbasis program Microsoft PowerPoint.

Sedangkan siswa yang akan diajar oleh guru yang terpilih, terlebih
dahulu diben prerest tentang aspek objek perhatian dan aspek subjek
perhatian.

Setelah siswa diberi prefest, langkah berikutnya adalab siswa
mendapat layanan dari guru yang terpilih, berupa pembelajaran sesuai
bidangnya dengan menggunakan program AMicrosoft PowerPoint. Setelah

siswa mengikuti pembelajaran, kepada mereka diberikan posftest dengan isi
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materi yang sama dengan pretest. Selanjutnya, hasil posttest dan pretest
dibandingkan untuk mengetahui pengaruh kemampuan guru setelah
mengikuti pelatihan menggunakan program Microsoff PowerPoint.

Berikut ini disajikan gambar bagan rancangan percobaan. Gambar
4.1., merupakan rancangan percobaan dengan sasaran guru peserta pelatihan

penggunaan program Microsofi PowerPoint.

X
O1 —— 02

KETERANGAN:

Ot Tlasll Observasd Sebelum Pelatilan
)2 lasil Observas! Sctelah Pelatihan
X t Perakuan berupa pelatihan

Pengaruh pelatihan=02- 01

Gambar 4.1. Bagan Penelitian Percobaan dengan Sasaran Guru

Sedangkan gambar 4.2., merupakan rancangan penelitian observasi

untuk mengetahui oufcome, dengan sasaran siswa yang menerima layanan
pembelajaran menggunakan media instruksional berbasis program Microsoft

PowerPoint.

TESIS PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO




IR-PERPUSTAKAAN UNIVERSITAS AIRLANGGA

PEM
MENGGUNAKAN
MPP
<>} <>
FLRHATIAN ot TrTm T e FEKRIIATIAN
SISWA SISWA

KETERANGAN:

1 : Perhatian Sebelum PBM Menggunakan MPP
Oz : Perhatian Setelsh PBM Menggunakan MPP
Pengnrab FBM Menggunabun MPP = 02 - 01

(Gambar 4.2. Bagan Penelitian Observasi dengan Sasaran Siswa

4.2. Populasi, Sampel, Besar sampel, dan Teknik Pengambilan Sampel
4.2.1. Populasi

Penelitian ini akan meneliti dua populasi. Guru yang berjumlah
13 orang dan populasi siswa berjumlah 262 orang.

Populasi penelitian yang pertama, adalah guru SMP Kristen
Petra 5 Surabaya. Seluruh guru berjumlah 13 orang, terdiri dari guru
tetap 2 orang dan Il orang guru tdak tetap. Guru Tetap adalah guru
yang kepadanya diberi tugas, tanggung jawab serta hak yang telah
ditetapkan oleh lembaga PPPK Petra. Guru Tetap selalu hadir setiap
hari. Sedang Guru Tidak Tetap adalah guru yang kepadanya diben
tugas, tanggung jawab serta hak yang telah ditetapkan oleh lembaga
PPPK Pettn dun Gdak selalu hado sehap han, Kehadoannyn sesoan

jadwal yang ditetapkan.
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Tabel 4.1. Data Populasi Guru SMP Kristen Petra 5 Surabaya

yang Belum Menguasai Penggunaan Microsof
PowerPoint (MPP).

| |
NO | STATUS GURU LML
: |
! GURU TETAP | 2
! P4 GURUTTIDAK TETAPR 1
| i JUMLAH 13

Sumber ; Humas SMP Kristen Petra 5

Populasi penelitian yang kedua, adalah siswa kelas VIII SMP

Kristen Petra 5 Surabaya.

4.2.2 Sampel
Ada dua sasaran sampel yang diteliti. Pertama, sampel guru.
Sampel guru terdiri dari seluruh populasi guru tetap maupun guru
tidak tetap yang belum mampu menggunakan Aficrosofi PowerPoint.
Kedua, sampel siswa. Sampel siswa merupakan seluruh populasi
siswa kelas VITT. Meskipun dalam satu jenjang kelas jumlah siswanya
banyak, namun langkah ini dilakukan dengan mempertimbangkan

kemudahan dalam penghitungan statistik.

4.2.3. Besar sampel
Penehitian 1im menggunakan sampel guru berjumlah 13 orang
terdinr seluruh populas: gure (etap maupun gurtu tdak tetap yang
beium mampu menggunakan program Microsoft PowerPoint,
Selanjutnya, dane semun peserta pelatiban akoan diambil 1

guru tetap atau guru tidak tetap yang paling mampu menggunakan
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program Adicrosaft  PowerPoint untuk memberi layanan PBM di
kelas VIII. Sedangkan sampel siswa terdiri dari seluruh populasi

siswa kelas VIII yang berjumlah 262 siswa.

4.2.4. Teknik pengambilan sampel

Tahap  pertama, sampel puru  diambil  dengan  cara

menyertakan seluruh populasi guru tetap maupun guru tidak tetap
yang belum mampu menggunakan program Microsofi PowerPoint.
Tahap kedua, sampel guru yang berjumlah [ orang
diperoleh dengan cara mengambil seorang guru bidang studi peserta
pelatihan dengan hasil nilai terbaik.
Sedangkan sampel siswa diperoleh dengan cara mengambil

seluruh populasi siswa kelas VIII yang berjumlah 262 siswa.

4.3. Variabel Penelitian

Pada penelitian ini variabel independennya adalah kemampuan guru
sebelum guru diberi pelatihan menggunakan program Microsofi
PowerPoint.  Kemampuan tersebut meliputi  kognitif, afektif, dan
psikomotor. Sedangkan variabel dependen yakni kemampuan guru setelah
guru diberi pelatihan. Adapun variabel luar yang tidak diteliti diantaranya
adalah 1Q, EI, SI, bakat, minat, pendidikan. Kedua variabel tersebut
diantarai oleh perlakuan berupa penyampaian modul, teori dan praktik

pembuatan media pembelajaran dengan menggunakan program Microsoft

PowerPoint.
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Variabel kemampuan dapat dinnet memnyadi sub vanabel, lalu dinmer
lagi menjadi indikator. Vanabel, sub variabel, dan indikator tersebut dapat
dirangkum sebagai kisi-kisi penelitian seperti tampak pada tabel 4.2
Indikator-indikator yang telah ditemukan sangat berguna sebagai bahan

dalam menyusun angket penelitian. Berikut ini disajikan kisi-kisi penelitian.

Tabel 4.2, Kisi-Kisi Penelitian

- - e

o sup ] NO.
VARIABEL VARIABEL | INDIKATOR I'TEM
1. Kesesuaian dengan kebutuhan |
1. Maten peserta.
2. Kesesualan dengan minat peserta. 2
> | 1. Sesuai dengan tujuan yang .
T L2 Metode hendak dicapa. '
E 2. Berpusat pada peserta latihan. 4
i ¥ 5
t 3. Fasilitas 1. Memenuhi jumlah peserta.
2. Layak pakai. I
: 7
4 Pelaksanaan L. Penjelasan.
2. Pemberian contoh. 8
! 1.1. Pemahaman
| 1.1.1. Memahami perintah-peritah |
dalam membuat presentasi.
L2 Awalisis
1.2.1. Memilah masing-masing fung-
> = si elemen dalam pembuatan 2
o .
= ‘: presentasi
3 A 1.3. Sintesis
§ s 1.3.1. Menghubungkan elemen
v, = pembuatan presentasi dengan
materni bidang studi yang 3
diajarkan.
1.4, Fvaluasi .
1.4.1. Menilai hasil akhir pembuatan 4
presentasi materi bidang studi.
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i‘ 2.1, VALUING
‘ 2.1.1. Menerima mla-mlat respect :
dan responsibiluy. ]
| 2.1.2. Kesediaan menerapkan nilai- 6
i nilai,
2.2, ORGANIZATION S
i 2.2.1. Mengkaitkan nilai-nilai lama
| dengan nilai-nilai baru. 7
| o . .. dengan niai-n __
= . 2.2.2. Mengatur dan menyusun nilai-
A { nilai lama dan baru menjadi 3
o | satu kesatuan,
l
: 2.3. CHARACTERIZATION BY
- VALUE OR VALUE COMPLEX
| 2.3.1. Menjadikan nilai-nilai lama
dan baru sebagai bagian dari 9
dirinya.
| 2.3.2. Menerapkan nilai-nilai lama
i dan baru dalam membuat 0
presentasi materi bidang studi.
3.1. REFLEX MOVEMENT AND
BASIC FUNDAMENTAL
MOVEMENTS
3.1.1. Menghentikan menombol tuts
keyboard secara refleks ketika 1
ada kesalahan mengetik,
3.1.2. Menombol tuts keybourd 12
g disertai melihat layar monitor.
= 3.2. PERCEPTUAL ABILITIES
§ 3.2.1. Menggunakan penginderaan 13
o pendengaran (auditori),
i 3.2.2. Menggunakan penginderaan 14
penglihatan (visual).
3.3. PHYSICAL ABILITIES
3.3.1. Keluwesan bekerja dalam s
membuat presentasi.
3.3.2. Ketangkasan dalam 16
mengoperasikan komputer,
3.4. SKILLED MOVEMENT e _
3.4.1. Melakukan gerakan sederhana 17
yaitu mengetik.
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i 1
3.4.2. Melakukan gerakan campuran
{merangkum, mendesain 18
presentasi, mengetik).
T
I 1.1. Tulisan berwarna '
| l.2. Gambar berwarna 2
1.3. Tulisan dengan susunan tambah 3
: baik
I Objek 1.4. Gambar dengan susunan tambah 4
baik
1.5. Tulisan bergerak 3
PERHATIAN 1.6. Gambar bergerak 6
2.1. Gemar melihat tulisan berwarna. {7
| 2.2. Gemar meliihat gambar bergerak. 8
l _ j 9
| 2. Subjek 2.3. Kebutuhan ilmu pengetahuan.
| | 2.4. Kebutuhan rasa ingin tahu, 10
2.5. Persiapan mengerjakan tugas. 1
2.6. Persiapan mengikuti ulangan. 12

4.4. Bahan Penelitian
Bahan penelitian adalah program AMicrosofi  Powerf’owt. Suatu
program perangkat lunak (Sofiware) komputer yang berfungsi untuk
meningkatkan kualitas tayangan suatu presentasi. Penelitian pada program
Microsoft  PowerPoint ini dioptimalkan pada batasan penggunaan (fungsi
program) secara praktis, bukan pembuatan pada substansi program perangkat

lunak (Sofiwarc).

4.5. Instrumen Penelitian
Instrumen yang digunakan dalam penelitian meliputi kuesioner,

daftar pertanyaan observasi, serta pedoman wawancara. Instrumen tersebut
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belum: bako meskipun disson berdasie pudi b ks pencliimne Muka
instrumen tersebut perlu menjalani uji validitas dan reliabilitas agar dapat

memberikan data yang akurat. Pengujian instrumen dilakukan dengan cara
Focus Group Discus (FGD).

Penelitian menggunakan instrument pendukung berupa modul

‘pelatihan tentang program Microsoft  PowerPoint. Modul digunakan

responden selama kurun waktu mengikuti pelatihan.

Lokasi dan Waktu Penelitian

Penelitian  dilaksanakan di SMP Kristen Petra 5 Surabaya.
Perimbangannya bahwa di SMIPP Kosten Petra > Suwrabaya belum pernah
diadakan penelitian terhadap permasalahan serupa, serta lokasinya mudah
dijangkau. Adapun penelitian dilaksanakan pada semester genap tahun
pelajaran 2005/2006 serta memperhatikan jadwal kegiatan pembelajaran di

sekolah.

Prosedur Pengambilan Data

Sebelum langkah pengambilan data dilakukan, kegiatan diawali
dengan mengajukan permohonan izin kepada kepala SMP Kristen Petra 5
Surabaya. Setelah mendapat izin penelitian, langkah selanjutnya adaléh
memberi pretest kepada guru yang belum mampu menggunakan program
Microsofi - P'owerPomnt. Setelahnya memberikan pelatihan  menggunakan
program Microsoft PowerPoint. Pelatihan dilaksanakan dua kali pertemuan
di laboratorium komputer SMP Kristen Petra 5 Surabaya. Setiap pertemuan

disediakan waktu 90 menit untuk penyampaian materi berupa teori dan
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praktek. Setiap pelatihan, peserta didampingi oleh dua tenaga instruktur yang
berasal dari penyelenggara pendidikan komputer Bangun Satya Wacana
(BSW) Wilayah Jawa Timur. Guru yang telah mendapatkan layanan pelatihan
penggunaan program Microsoft  PowerPoint diberi kesempatan untuk
mendemontrasikan kemampuannya dalam penggunaan program Microsofi
PowerPoint pada Proses Belajar Mengajar (PBM) di kelas.

Pengambilan data dilakukan dengan menggunakan instrumen
observasi. Keglatan observasi dilaksanakan secara berperan serta (Participant
Observation). Pengambilan data secara observasi nonpartisipan dilaksanakan
ketika guru mendemontrasikan kemampuannya dalam penggunaan program

Abcrosoft 'owerl'omt puda Proses Belugar Mengagar (PBM) di kelas,

Pengambilan data secara observasi nonpartisipan dilaksanakan
terhadap siswa sebelum dan setelah siswa menerima layanan pembelajaran
menggunakan program Microsofi  PowerPoint. Penggunaan instrumen
penelitian berupa kuesioner dan wawancara dilaksanakan setelah guru
mengtkuti pelatihan program  Aficrosefi  PowerPoist dan siswa selesal
mendapat layanan pembelajaran dengan menggunakan program Microsoft
Poswerl'oms. Penyumpaan snsttumen huesionet  dilubsanahan  dengan
memberikan langsung kepada responden serta menunggunya hingga
responden selesai menjawab seluruh pertanyaan dalam kuesioner tersebut.,

Sasaran pengambilan data primer penelitian meliputi kepala sekolah,
mstruktur, guru, siswa kelas VIIl. Sedang data sekunder diperoleh dari

dokumoen di sekoluh
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4.8. Cara Pengolahan dan Analisis Data
4.8.1. Pengolahan data meliputi:
a. Pemeriksaan Data (£diting)

Editing adalah proses untuk menelit: apakah jawaban yang
ada pada angket sudah sesuar dengan pertanyaan dalam
angketnya. Jawaban responden dalam wawancara ditelitt ulang
apakah sudah sesuai dengan item yang ditanyakan dalam daftar
wawancara. Demikian pula meneliti apakah hasil observasi telah
sesuai dengan item observasi.

b. Pembuatan Kode (Data Coding)

Datu  coding merupakan proses penyusunan secara
sistematis data mentah (yang ada dalam kuesioner) ke dalam
bentuk yang mudah dibaca oleh komputer.

c. Pemindahan Data (Dara Frtering)

Data FEntering adalah proses memindahkan data yang
telah diubah menjadi kode ke dalam komputer. Program
komputer yang dipakal adalah Microsofi Excel dan SPSS
(Statistical Package for Social Science).

d. Pembersih Data (Data Cleaning)

Data Cleaning adalah proses untuk memastikan bahwa

seluruh data yang dimasukkan ke komputer telah sesual.
¢. Penyajian Data (Data Crutprut)
Data Ouiput merupakan hasil pengolahan data. Bentuknya

berupa angka dalam tabel dan chart.
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4.8.2. Analisis Data.

Analisis data merupakan kegiatan yang meliputi
pengelompokan data berdasar variabel dan jemis responden,
mentabulasi data berdasar variabel dari selurub responden,
menyajikan data dari tiap variabel yang diteliti, melakukan
penghitungan untuk menjawab rumusan masalah, serta melakukan
penghitungan untuk menguji hipotesis yang diajukan. Besarnya

hubungan antar variabel dicari dengan membandingkan.
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BAB S

ANATISTS DAN HASH. PENELTTIAN

5.1 Karakteristik Penelitian

Penclivan  dilaksanakan  di SMP Kosten Petra 5 Surabaya.
Pertimbangannya bahwa di SMP Kristen Petra 3 Surabaya belum pernah
diadakan penelitian terhadap permasalahan serupa. serta lokasinya mudah
dijangkau. Penelitian dilaksanakan pada semester genap tahun pelajaran
2005 2006 serta memperhatikan jadwal kegiatan pembelajaran di sekolnh

Kondisi lokasi penelitian dapat digambarkan sebagai berikut. SMP
Kusten Peta > Surabava merupakan salali satu wint pendidihan dibasah
naungan Perhimpunan Pendidikan dan Pengajaran Kristen Petra (PPPK
Petra} Surabaya. Visi yang dimiliki SMP Kristen Petra 5 Surabaya adalah
menjadi sekolah terbaik di Indonesia  Sedanpkan 7 musinva vaitu |
Melangkah berdasar Alkitab dan pengakuan iman rasuli; 2. Memberikan
pendidikin dan pengiginan terbark, 3 Mengembanghan wasvasan nasonal
dan global; 4. Menciptakan komumkasi timbal balik dalam proses belajar
mengajar; S Menumbuhkan kesadaran lingkungan dan ciptaan Tuhan: 6.
Membina kesetiakawanan vang positit'dan mengasthi sesama: 7. Membina
kepribadian yang utuh dan dinamis. Untuk mencapal visi misi tersebut
maka diperfukan 4 kata operasional, antara Tan [ D1 atas rata-rata; 2.
Target: 3. Berpikir dan bertindak luar biasa; 4. Terkait masa depan.

Seluruh guru berjumlah 47 orang, jumlah guru perempuan 26, guru

laki-laki 21 Usia guru rata-rata usia 40 th. Dart scluruh guru yang ada,

an
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vang berpendidikan diploma 2 orang (4.2%), pendidikan strata satu 41
orang (872%), dan vang berpendidikan strata dua 4 orang (8,5%). Dan
sept status, ada 27 puru tetap dan 20 gurn tidak 1etap

Keadaan siswa digambarkan sebagal berikut. Jumlah keseluruhan
747 siswa, terdiri dari kelas VII berjumlah 254 siswa, kelas VI berjumiah

262 serta kelas I benjumlah 251 siswa,

5.2  Karakteristik Responden.

Peneliian e menggunahan dua macan wespoiden, Responden
guru dan responden siswa.

5.2.1 Responden Guru.
Guru vang yvang belum bisa menggunakan program Aficrosofi
Powerpoint berjumlah 13 orang, terdirt darn 2 guru tetap dan 11 guru
ndak tetap. Namun saat pelatihan berlangsung vang tndak  bisa
mengikuti adalah 3 guru tidak tetap Karena jadwal pelatihan
berbenturan dengan jadwal mengajar di sekolah lain. Maka pelatthan
menggunakan program Aficrosoft Powerpont dukuti oleh 10 guru
vang terdiri dart guru bidang studi Olah Raga dan Kesehatan = |
orang, Bimbingan dan Konseling =2 orang, Bahasa Indonesia 2
orang, Sent Rupa - | orang, PPKn = 2 orang, Geografi = [ orang,
Bahasa [nggris = 1 orang. Jumlah guru wanita - 7, sedang jumlah
sura pria 3 orang. Pelatihan dilaksanakan dua kab pertemuan yang
masimg-masing  pertemuan  berfangsung 90 menit. Pelatihan
diaksanakan scusai guru melaksanakan jam  pembelajaran  dan

bertempat di laboratortum komputer.
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5.2.2 Responden Siswa,
Responden siswa diambil dari seluruh populasi siswa kelas
VI yang berjumlah 262 dengan rincian, jumlah siswa perempuan

137 dan siswa laki-laki 125,

5.3  Variabel yang Dibahas.
Variabel independennya adalah pelatihan penggunaan program

Microsoft PowerPoint. Sedang variabel dependennya adalah kemampuan
guty  dalam  pembelagaran menggunihan  medi innhiuhsional  herbass

program Microsoff PowerPoint.

5.4 Metode yang Dipakai
Penelitian ini merupakan pra eksperimental, yaitu mencari

hubungan sebab akibat dari suatu gejala atau kejadian yang ada. Penelitian
mencari hubungan antara sebelum dan setelah pelatithan program Adrcrosoft
PenwerPoint bagi puru. Sedangkan penelitian: observasi digunakan untuk
mengetahui pengaruh kemampuan guru terhadap perhatian siswa dalam

pembelajaran dengan menggunakan program Microsoft PowerPoint.

5.5 Data Penelitian
Dari proses pengambilan data, diperolel dala penclitian schagal
berikut.
5.5.1. Data Skor Kemampuan Guru

Sebelum dan setelah pelatihan menggunakan Microsoft

Powerpoint diperoleh data sebagai berikut:

TESIS
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Tabel 5.1 Skor Kemampuan Guru Sebelum dan Setelah
Pelatthan Mocrenafe Power e

| i : SEBELUM i SETELAH ‘
: i KODE ! !‘F.I.A'I'IILI_\N \ I'IT‘I.A'I'IHAN :
BT Eettee S S U U AR R
GURU . KOG ' AFEK I’blh()i KOG . AFER © PSIKO
_; . UML I ML ML | UML ML [ ML |
Lo WR Oy 3 e IS 22 27
R Y LT T B I ’ 16 \ 14 | 1l A1l
| e [ 8 l BRI N L S S T S
A INC D8 9T a6 s 19 |28
S Sz 7. M t8 14 20 1 28
o ms e oz s e 20 | 28
' ni . " : 1 i I . |- . i Ry |
% SM | 8 | 9 | 16 | 15 18 \ .2.8_ ¥
o] EM_ |8 |13 Lhs s | 2] [
U VU T N T I| zl :
Co M 8y 118 Lo 147 204 | 28Y
Neterangan :

SBI. - Sebelum Pelatihan
STIL. - Setelah Pelatihan

Fraga e ate Talashicme s dadany slalooon o A e aada e e baapan benkout
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SKOR |

35

30

25

20

15

10 l

o HIEH SN P S BN YR

RWPE TP NI SN TB MSMEPA |

| GURU |
e

D PSIKOMOTOR SEB)ELUM)?
0 KOGNITIF (SETELAH)

m AFEKTIF (SETELAH

B PSIKOMOTOR(SETELAH)

Gambar 5.1 Skor Kemampuan Guru Sebelum
dan Setelah Pelatihan MPP
5.5.2 Data Skor Perhatian Siswa
Penelitian yang dilaksanakan saat sebelum dan setelah Proses
Belajar Mengajar (PBM) dengan menggunakan Microsoft Powerpoint,

menghasilkan data sebagai berikut:
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Tabel S Skor Perhatian Siswa Dalam PBM,
Sebelum dan Setelah Menggunakan Microsoft
Powerpoint
SKOR PERHATIAN DALAM PBM
URAIAN NON MPP MPP SELISTH
bOTW 44| 837 396
| GW | 48 ;863 405
i 1. ASPEK B T B 7Y T T 7 S ' A
OBILK G | oase | e | o8
TG i 429 873 444
(G 414 849 418
T Tskor | P L 3ss 2668 | 1306
ASPEK L T 1218 2375 1157 )
_ OBIEK ymp 2573 | s036 | 2463 |
| SW 420 800 380
SG 426 763 337
2. ASPEK Bl 687 846 159
SUBIEK IT 745 83¢% 04
| | TT 702 8438 146
T O Ra7 |55
sko [P | we2x bo3ses  |ooa2
ASPEK | L 1759 2388 | 629
SUBJEK | ML 3682 4953 1271
CUSKORT de T T e T sz T oaw
TOTAL 1 2977 4703 1780
PERHATIAN
(Poin 1 12 | IML 6255 oagy L 3734
Keterangan :
Jumlah Siswa Perempuan (P) 125 siswa
Jumlah Siswa Laki-laki (L) : 137 siswa
Jumlah Total Siswa Kis VIIl : 262 siswa
Arti Kode sebagal berikut:
W : Tulisan berwarna
GW  : Gambar berwarna
Tl “Tabisan (ersusun secara lan dart Diasany:
UL . Gambar tersusun secara lain dan biasanya
TG - Tulisan bergerak
GG - Gambar bergerak
SW . Senang terhadap objek berwarna
SG - Senang terhadap objek bergerak
BI - Kebutuhan akan ilmu pengetahuan
IT - Kebutuhan rasa ingin tahu
TT : Kebutuhan tanggung jawab terhadap tugas
TU . Kebutuhan persiapan menghadapai ulangan
Non MPP - Tidak menggunakan Microsoft Powerpoint
MIP - Menggunakan Microsoft Powerponid
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Data di atas dapat dibuat dalam beberapa Chart sebagai berikut:

|
|
PERHA_SBL PERHA_STL !
PERHATIAN

+ _@Perempuan ® Laki-laki’

Keterangan:
PERHA SBL : Perhatian dalam PBM sebelum menggunakan MPP
PERHA_STL : Perhatian dalam PBM setelah menggunakan MPP

Gambar 5.2 Skor Perhatian Siswa dalam PBM Sebelum
dan Setelah Menggunakan MPP,

| SKOR

OBJEK SBL ~ OBJEKSTL  SUBJEK SBL  SUBJEK STL |
ASPEK PERHATIAN |
! '@ Perempuan G Laki laki '
L e m———
Keterangan:

OBJEK SBL : Objek perhatian dalam PBM sebelum menggunakan MPP
OBJEK STL : Objek perhatian dalam PBM setelah menggunakan MPP
SUBJEK_SBL : Subjek perhatian dalam PBM sebelum menggunakan MPP
SUBJEK_STL - Subjek perhatian dajam PBM setelah menggunakan MPP

Gambar 5.3 Skor Dua Aspek Perhatian Siswa dalam PBM
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1TW 2GW 3TL 4GL 5TG 6GG 75W 885G 9B 10T 11 TT 12TV

ASPEK PERHATIAN

———— - - . ————

B SEBELUM DENGAN MPP @ SETELAH DENGAN MPFP b

Gambar 5.4 Skor Seluruh Aspek Perhatian Siswa datam PBM
Sebelum dan Setelah Mengggunakan MPP

e e - . JR— o ,

1TTW2GW 3TL 4GL 5TG 6GG
ASPEK OBJEK PERHATIAN

: e ' |
; H NONMPP @ MPP |

Gambar 5.5 Skor Aspek Objek Perhatian pada PBM
dengan Non MPP dan PBM dengan MPP

SKOR

18W 28G 3Bl 41T S5TT 87U
ASPEX SUBJEK PERHATIAN

_—_— —_

" NONMPP B MPP |

. — ]

Gambar 5.6 Skor Aspek Subjek Perhatian pada PBM
dengan Non MPP dan PBM dengan MPP
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5.6. Analisis dan Interpretasi

Data penelitian yang diperoleh selanjutnya diolah dan dianalisis.
Pengolahan data penelitian dilakukan dengan menggunakan program
Microsofi Excel dan program SPSS (Statistical Product and Service
Solutions) versi 14.0. Analisis terhadap hasil pengolahan data dilakukan
‘dengan memperhatikan Dasar Pengambilan Keputusan (DPK) serta mengacu
pada 2 (dua) hipotesis penelitian.

Hipotesis perfumu, pelatihan  penggunaan  program Microsofi
PowerPoint mempengaruhi kemampuan baik kognitif, afektif, maupun
psikomotorik guru dalam proses pembelajaran. Jika diturunkan dalam
hipotesis statistik menjadi;

H, - Pelatihan penggunaan program Microsofi 'owerfoint mempengaruhi
kemampuan baik kognitif, afektif, maupun psikomotorik guru dalam -
proses pembelajaran.

Hipotesis kedua, penggunaan program Microsoft PowerPoint dalam
proses pembelajaran mempengaruhi perhatian siswa. Jika diturunkan dalam
hipotesis statistik menjadi:

Hy = Penggunaan program Microsofi Powerloint dalam proses
pembelajaran mempengaruhi perhatian siswa.

Adapun dasar pengambilan keputusan meliputi:
a. Pengujian dengan dua sisi ({wo tailed test),
b. Tingkat signifikansi adalah (a) = 0,05.

¢. Nilai Probabilitas:

» Jika probabilitas - 0,05, to ditolak.
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¢ Jika probabilitas - 0,05 Ho diterima.

Berikut pengolahan data penelitian tentang kemampuan guru dalam

menggunakan program Aficrosofi PowerPoint beserta analisisnya.

5.6.1 Kemampuan Guru
56.1. 1. Kognitit Guru
Sebelum pelatihan, kognitif guru rata-rata 8,50. Setelah
pelatithan, guru memiliki kognitif rata-rata [4.70.
Berdasarkan pada nilai probabtlitas vang - 0,05 maka tlo
ditolak. Kesimpulannya bahwa pelatiban efektit mempengaruht

Kognitil puru.

56.1.2  Afektt Guru
Sebelum pelatihan, afektif guru rata-rata 11,80, Setelah
pelatihan, guru memibiki afektif rata-rata 20,40,
Berdasarkan pada miai probabilitas vang -~ 0.05. maka Ho
ditolak. Kesimpulannya bahwa pelatihan etektit mempengaruhi

afekuf guru.

5.6.1.3. Psikomotorik Gruru
Sebelum pelatihan, psikomotorik guru rata-rata 16,60,
Setelah pelatthan, guru memiliki psikomotorik rata-rata 28.90.
Berdasarkan pada nilai probabilitas vang < 0,05, maka Ho
ditolak. Kesimpulannya bahwa pelatihan efektif’ mempengaruhi

pstkomotortk guru.
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Berikuinya adalah pengolaban data penelian tentang perhatian
siswa dalain PBM menggunakan program Alicrosoft Powerl'omt beserta

analisisnya.

5.6.2. Perhatian Siswa

Seperti pada pengolahan data kemampuan guru, pengolahan data
tentang perhatian siswa  dilakukan dengan menggunakan program
Microsofi Fxcel dan program SPSS versi 14.0. Hasil pengolahan dengan
menggunakan progrant Alicravoft Fyeel tampak bahwa 1 hitunge - 127,03
ditentukan oleh kegiatan PBM  dengan menggunakan MPP. Masih
dimungkinkan lagi  bila  guru mau menyapkan  materi  dengan
mengoptimalkan  sound  effecr vang  ada  dalam  program  Microsofi
PowerPomt tersebul,

Selanjuinva data tentang perhatian vang diolah meliputi aspek

objek perhatian dan subjek perhatian siswa.

5.6.2.1 Perhatian Siswa Sebelum dan Setelah PBM Menggunakan Program MPP.
Sebelum PBM menggunakan MPP perhatian siswa rata-rata 23.9.
Setelah PBM menggunakan MPP perhatian siswa rata-rata 38,1
Berdasarkan pada milan probalsditas yang - 0,05, maka Ho diolak
Kesimpulannya bahwa PBM dengan MPP efektif mempengaruhi perhatian
SIswa,
5.6.2.2 Penilaian Siswa terhadap Aspek Perhatian.
Hasil Penilaian Siswa terhadap Aspek Perhatian (Versi /-ricdmun

{est) sebagat berikut.
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L Salabh satuc dari cmpat aspek olyek perhatian mendapat penhinim
lebih da'ri s1sWa.
Berdasarkan pada nilai probabilitas - 005, maka o diolak.
Kesimpulannya bahwa salah satu dani empat aspek objek perhatian

mendapat penilaian lebih dan siswa.

5.6.2.2 1. Pentlaian Siswa terhadap Empat Aspek Subjek Perbatian,

[ Salah sata dare emynat aspek subgpeh perhatian mendapat pentlaiimn
lebih dari siswa.
Berdasarkan pada nilar probabilitas = 0,05, maka Ho diterima.
Kesimpulannva bahwa keempat aspek subjek perhatian mendapat

penilalan yang sama dan siswa. |

5.6.2.2.2 Hasil Kesepakatan Siswa terhadap Aspek Perhatian (Versy Aendall s 1Y

Test),

H, = Ada keselarasans kesepakatan dv antara responden mential
kedelapan aspek perhatian.
Berdasarkan pada miar probabildas - 0,05, maka 1o ditolak.
Kesimpulannya bahwa ada keselarasan/ kesepakatan di antara

responden dalam menilai kedelapan aspek perhatian.
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BAB 6

PEMBAHASAN

6.1. Gambaran Umum Sebelum Penelitian
Ketika SMP Kristen Petra 5 belum mengoptimalkan pembelajaran
" secara multimodal, maka muncul berbagai pertayaan. Diantaranya adalah,
perlukah diadakan pelatihan untuk peningkatan kemampuan guru? Kalau

benar perlu diadakan pelatihan, adakah pengaruh berupa o terhadap

peningkatan kemampuan guru? Pertanyaan selanjutnya adalah bila guru telah
meningkat kemampuannya, apakah ada pengaruh berupa owcome terhadap
peserta didiknya?

Dari pertanyaan tersebut akhirnya terpilih dua rumusan masalah
penelitian. Pertama. Apakah pelatihan penggunaan program AMicrosofi
PowerPoint dapat mempengaruhi kemampuan baik kognitif, afektif, maupun
psikomotorik guru dalam proses pembelajaran? Kedua Apakah penggunaan
program Microsoft PowerPoint dalam proses pembelajaran dapat
mempengaruhi perhattan siswa”

Maka tujuan penelitian ditetapkan yaitu untuk menganalisis pengaruh
pelatihan penggunaan program Microsofi PowerPomt terhadap kemampuan
guru dalam meningkatkan perhatian siswa kelas VIII SMP Kristen Petra 5
Surabaya.

Berdasar teor1 yang ada maka disusunlfah pula dua hipotesis. Pertama,
bahwa pelatihan penggunaan program AMicrosofi PowerPoint dapz.lt

mempengaruhi kemampuan baik kognitif, atektif, maupun psikomotorik guru

45
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dalam proses pembelajaran. Kedua, penggunaan program Aficrosofi
PowerPoint dalam pembelajaran dapat mempengaruhi perhatian siswa.

Teori yang dimaksud dan yang terkait dengan kemampuan guru
adalah  pendapat Bloom, vang  menyatakan  bahwa  cara  individu
mengungkapkan hasil pembelajaran  berada dalam kawasan kognitif,

~ afektit, dan psikomotor. Sedangkan Gagne, menyatakan bahwa setidaknya
ada ma macam perubahan perilaku akibat pengalaman yakni: 1. Belajar
responden, 2 Belajar  kontiguitas, 3. Belajar operant, 4. Belajar
obscrvastonal. dan S Belajar kognitit™ Demikian pula Robert 1 Mathis dan
John H. Jackson, menyatakan bahwa pelatihan kerja-ketrampilan (job-skiil
traning) adalah bagian dan pelatihan dan pengembangan Sumber Daya
Manusia (SDM).

Sedangkan teori vang terkait dengan perhatian siswa adalah pendapat
Suryabrata. Dia menyatakan bahwa vang menarik perhatian adalah hal yang
ketuar dart konteksnya atau dengan kata lain, hal vang menarik adalah hal
yang lain dari pada yang lain. Hal lain tersebut bisa timbul dari warna,
gerakan. susunan, serta kebiasaan. Selain objek, Suryabrata juga menvatakan
bahwa hal yang menarik adalah hal yang sangat bersangkut paut dengan

pribadi subjek. Misalnva: kebutuhan, kegemaran, pekerjaan atau keahlian.

6.2 Metode Penelitian
Penelitian yang memerlukan dua kelompok responden yaitu guru dan
siswa Inl menggunakan mctode pra cksperimental dan obscrvasi. Pada
penelitian pra eksperimental, variabel independen yang digunakan berupa

pelatihan penggunaan program Microsofi Poweri’vint. Variabel dependennya
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adalah kemampuan guru  Sedangkan pada penelittan ebscervasi, variabel
independennya vaitu perhatian siswa dalam PBM scbelum menggunakan

MPP. Variabel dependennya yaitu perhatian siswa dalam PBM setelah

menggunakan MPP.

Analisis Hasil Penelitian dan Interpretasi

Berkaitan dengan hipotesis penelitian, maka data vang dikumpulkan
untuk kegiatan penelitian ternyata mendukung kedua hipotests penelitian.
Hipotesis vang pertama telah terbukti, bahwa pelatihan PENEEUNAAN Program
Microsoft PowerPomt mempengaruhi kemampuan baik kognitif, afekuf]
maupun psikomotortk gure. Terbukt 1 hitung setiap aspek secara berurutan
adaltah: kognitit - -127 03; afektif - -153.70; psikomotorik = -343 91

Hipotesis yang kedua, yaitu penggunaan program Aicrosofi
PowerPomt dalam proses pembelajaran mempengaruhi perhatian siswa. Pada
t hitung diperoleh angka -14,52. Pentngkatan perhatian siswa terhadap PBM
dengan menggunakan MPP cukup berarti. Perhatian siswa yang terbesar
terfokus pada aspek objek perhatian berupa tulisan yang bergerak, diikuti
secara berturut-turut aspek objek perhatian gambar berwarna, gambar
bergerak, dan tulisan berwarna. Aspek subjek perhatian yang terdapat dalam
din siswa yang meliputt: senang terhadap warna, senang terhadap gambar,
kebutuhan ilmu  pengetahuan  dan  kebutuhan  bertanggung  jawab
menyelesaikan tugas-tugas mendapat perhatian dan penilaian dari siswa.
Artinya bahwa siswa memberi perhatian serta penilaian yang sama

terhadap masing-masing aspek subjek perhatian yang ada dalam dirinya.
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Tidak ada perhatian yang lebih menonjol terhadap salah satu aspek subjek
perhatian yang lain. Dan mereka sepakat dalam menilai seluruh aspek
perhatian yany ada.

Dengan demikian dari hasil pengolahan data serta analisis penelitian

menunjukkan bahwa pertama, pelatihan penggunaan program Aficrosofi

" PowerPoini dapat mempengaruhi kemampuan baik kognitif, afektif, maupun

6.4

TESIS

psikomotorik guru dalam proses pembelajaran. Kedua, penggunaan program
Microsoft PowerPoint dalam proses pembelajaran dapat mempengaruhi
perhatian siswa. Bila hasil penelitian dihubungkan dengan teori, maka hal ity

merupakan bukti dukungan terhadap teori yang dipakai dalam penelitian ini.

Keterbatasan Penelitian

Penelitian ini memuliki segi keterbatasan. Keterbatasan penelitian
yang pertama, adalah tidak adanya kelompok kontrol Kedua, waktu yang
tersedia untuk pelatihan hanya dua kali pertemuan, sehingga dimungkinkan
kurang optimalnya guru dalam persiapan PBM menggunakan program
Microsoft PowerPoinr. Ketiga, terlalu pendeknya waktu antara setelah guru
selesai pelatihan dengan jadwal harus segera presentasi hasil pelatihan dalam
PBM di kelas, semingga dimungkinkan presentasi yang disajikan kurang
optimal, Maka, bagi peneliti lain yang berminat terhadap objek penelitian ini

atau yang serupa, hal in1 merupakan peluang yang menantang untuk diteliti.
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BAB 7

PENUTUP

7.1. Kesimpulan
Dari hasil kegiatan penelitian, maka berikut ini disajikan berapa hal
_sebagai kesimpulan.
7.1.1. Rumusan Masalah
* Dua rumusan masalah penehitian telah terjawab. Pertama, bahwa
pelatihan  penggunaan program Microsofi  PowerPoint dapat
mempengaruhi kemampuan guru. Kedua, penggunaan program
Microsofi  PowerPoint dalam proses pembelajaran dapat
mempengaruhi perhatian siswa kelas VIII,
7.1.2. Hal Perhatian.
* Objek perhatian yang disajikan melalui media pembelajaran
Microsoft PowerPoint mendapat perhatian secara nyata dari siswa.
Siswa membert perhatian secara lebih baik terhadap masing-
masing aspek objek perhatian.
» Subjek perhatian yang terdapat dalam diri siswa, mendapé.t
perhatian dan penilaian dari siswa. Siswa memberi perhatian dan

penilaian secara sama terhadap masing-masing aspek subjek

perhatian.

7.2, Saran

7.2.1. Manfaat yang Diperoleh
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Berikut disajikan beberapa manfaat yang bisa diperoleh dalam

penelitian serta saran membangun bag) pihak yang terkait.

Keberhasilan  pelatihan dalam mempengaruhi  peningkatar
kemampuan guru ditunjukkan dengan hasil t hitung pada masing-
masing aspek kemampuan sebagai berikut: a. Kognitif — -127.03 |
b. Afekuf  -153.70: c¢. Psikomotorik —-343.91.

Ada peningkatan perhatian dari siswa dengan t hitung = -14.25.
Hasil peneliian menyarankan bahwa selain guru harus terus
meningkatkan kemampuannya secara individu, maka pihak sekolak
Juga perlu menindaklanjuti dengan memberi kesempatan kepada
guru untuk melatth din dengan maten yang telah diperolch.
sehingga perhatian siswa diharapkan dapat lebih meningkat
Setelah itu barulah guru diberi materi pelatiban tingkat lanjut. Jik:
tahapannva tidak demikian maka akan terjadi banyak kerugian
Kerugian tersebut antara lain: tidak adanya peningkatan perhatiar
oleh siswa. dimungkinkan justru siswa akan mengalam:
demotivasi, gure menjadi tidak optimal dalam mengaktualisasikar
kemampuannva, pihak sckolah maupun pihak PPPK Petra akan
mengalami kerugian dan segi capatan pembelajaran dan dana.
Penentuan tingkat kecepatan pada objek bergerak, baik tulisar
bergerak atau gambar bergerak, sebaiknya proporsional. Pada leve!
gerak paling lambat, akan mengakibatkan perasaan jenuh pemirsa
(siswa) datam menunggu atas informasi vang akan disampatkan

serta pemborosan waktu befajar. Namun pada fevel gerak vany
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terlalu cepat, menimbulkan perasaan tidak nyaman karena ada
keterkejutan. Lama tayangan hendaknya juga proporsional.
Tayangan yang terlalu lama, memimbulkan perasaan bosan.
Karena tidak menimbulkan motivasi pemirsa (siswa) untuk segera
menuntaskan informasi yang disajikan. Namun tayangan yang
terlalu cepat berganti, dapat menimbulkan perasaan putus asa. ltu
karena pemirsa (siswa) merasa tertinggal atas informasi yang

dibutuhkannya.

» Penggunaan MPP harus mempertimbangkan minat individu

terhadap warna beserta intensitas yang menyertai pada setiap
warnanva. Dalam mendesain tayangan hendaknva menggunakan
prinsip dan aturan dalam mengkomposisi warna, sehingga hasilnva

nyaman dilihat.

* Apabila ada data dari pihak Usaha Kesehatan Sekolah (UKS) yang

menyatakan bahwa ada siswa yang buta warna, maka hendaknva
guru memberikan penjelasan tambahan kepada siswa vang buta
warna tersebut. Hal demikian penting dilakukan demi peningkatan
minat belajar siswa serta efektivitas penyampaian materi itu

sendin

7.2.2 Kelemahan

TESIS

Benkut beberapa kelemahan vang perlu  menjadi  bahan
pertimbangan untuk penvempurnaan pada waktu-wakiu mendatang.
Khususnya bagi penelitt lain vang berminat dalam pelaksanaan

peneliian sejens,
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[

¢ Pencliian im tidak menggunakan ketompok kontrol.
* Wakuw yang tersedia untuk pelatihan hanya dua kali pertemuan,
* Terlalu pendeknya waktu antara setelah guru selesai pelatihan

dengan jadwal harus segera presentasi hasil pelatihan dalam PBM.

7.2.5 Penehitian anjutan

vengan adanya keterbatasan dan kelemahan dalam penelitian
ini, maka peluang yang juga merupakan tantangan masih terbuka luas
bagi penzliti lain yang berminat mendalami seputar permasalahan yang

sangat menartk ni.
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MEMBUAT SLIDE PEMBELAJARAN
MENGGUNAKAN
MICROSOFT POWERPOINT

A. PENDAHULUAN

Microsoft  PowerPoint  adalah program vyang dirancang untuk
menyiapkan presentasi. Presentasi baik dalam seminar, lokakarya maupun
proses belajar mengajar.

Program ini dapat memvisuahsasikan data maupun gagasan secara
menarik dengan menggunakan fasilitas efek tampilan. Huruf, gambar animasi,
dan foto merupakan objek yang dapat didesain hingga menghasilkan media
presentasi berupa siide yang sangat menarik. Bahkan Microsoft PowerPoint
menyediakan sarana pendukung suara (audio) untuk memberikan effect dan
ilustrasi saat s/ide ditayangkan.

Modul ini memuat beberapa pedoman yang perlu diperhatikan dalam
pembuatan sfide dengan Microsofi PowerPoint. Hal ini agar sesuai dengan
tujuan pembuatan program Microsoft PowerPoint itu sendiri.

Sistemnatika modul ini terdin atas: teori pembuatan slide dengan
Microsoft PowerPoini, praktek membuat slide dengan Microsofi PowerPoint,
dan penugasan. Penugasan merupakan kegiatan pembuatan s/ide Microsoft

PowerPoint untuk settap guru sesuai bidang studi vang diajarkan.

B. TEORI PEMBUATAN SLIDE DENGAN MICROSOFT POWERPOINT
Tuwuan utama pengadaan fasilitas Microsoft PowerPoint adalah untuk

menampilkan tavangan presentasi berupa {s/ide) yang menarik, sederhana, dan
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mudah dipahami pemirsa (siswa). Maka beberapa hal yang perlu diperhatikan

antara lain:

13

Ly

L

TESIS

Gunakan gambar animasi. karikatur, dan foto yang sesuai sebagai
1lustrasi pendukung data.

Gunakan komposisi warmna secara proporsional. Tayangan s/ide
terkesan sejuk bila secara proporsional jumlah pixe/ warna-warna
"dingin’ (ungu. ungu kebiru-biruan, biru, biru kehijau-hijauan, hijau,
hijau kekuning-kuningan) lebih banyak daripada jumlah pixe/ warna-
wama ‘panas’ (kuning, kuning keorange-orangean, orange, orange
kemerah-merahan. merah, merah keungu-unguan).

Gunakan unsur gerak. Tulisan dan gambar bergerak pada awal
penayangan s/ide |lebth menarik perhatian pemirsa. Aturlah agar s/ide
muncul dengan gerakan yang wvariatif Caranya dengan
mengkombinasikan antara kecepatan dan ragam gerakan.

Optimalkan fungst suara vang tersedia. Perlu pengaturan pada
volume suara agar tidak mendominasi pembicara yang sedang
menjelaskan. Pemirsa (siswa) akan lebih nyaman saat mendengarkan
penjelasan pembicara ketika musik mengalun dengan sayup-sayup
terdengar. Musik instrumental aliran klasik lebih disarankan sebagai
pendukung saat s/ide ditayangkan

Latar belakang vang dominan (misalnya: warna lebih cerah, ilustras
lebih ramat), akan mengganggu objek di depannya. Seharusnya objek

vang di depan mendapat perhatian penuh.

PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO




IR-PERPUSTAKAAN UNIVERSITAS AIRLANGGA 6l

6. Menggunakan kata, kalimat, dan ilustrasi sederhana agar pemirsa
cepat memahami isi pesan yang ditayangkan.

Bila slide Microsofi PowerPoint telah selesat dibuat, maka untuk

menayangkannya perlu bantuan berupa LCD (liguid Crystal Display).

Melalui LCD ini, slide ditayangkan dalam format besar sehingga pemirsa

dalam sebuah kelompok dapat melihatnya secara jelas.

C. PRAKTEK MEMBUAT SLIDE DENGAN MICROSOFT POWERPOINT
Berikut langkah-langkah dalam pembuatan slide dengan menggunakan
program Microsoft PowerPoint:

1. Aktifkan Power Point. Pilth Biank Presentation.

2. Pilih menu /ile, Page Serup. Perhatikan kotak dialog Page Setup. Program

secara otomatis men-sefup pada tahap awal.

tal

e e
Eew | .
i
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Akttkan /nsert Picture. Pilihlah foto Water lilies.jpg. Copy foto

tersebut dan klik paste pada bagian ¢ /ick to Add Subtitle.

KLk /nsert lalu klik new s/ide. Sekarang memiliki slide kosong vang baru.
Ketik: MATA PELAJARAN. Klik /nsert WordA4re. Klik pilihan kolom
pertama baris satu. Ketik: BUDI PEKERTI. Ketik: NAMA GURU, Drs.
Eddy Purwanto (nama diis1 sesuai nama guru masing-masing) pada (/ick 1o
Add Subtitle,

Ulangi langkah 5. Klik /nsert WordArr. Pilih tipe huruf pada kolom empat
baris tiga. Ketik: 3 COMPONENTS GOOD CHARACTER pada (ick to
Add Tule.
Ulangt langkah 5. Ketik 3 COMPONENTS GOOD CHARACTER pada
Chick to Add Title. Klik oval, Buatlah bidang elips. Kiik Add Text, lalu
ketik: MORAL KNOWING. Cara vang sama untuk MORAL FEELING,
dan MORAL ACTION. Kk AutoShapes, klik connectors. Atur agar ada
hubungan.

Ulangi langkah 5. Ketik: MORAL KNOWING pada ( fick to Add Titie.
Ketik  Tahu nilai-nilai moral, Tahu alas an moral, Tahu manfaat moral
pada ( lick to Add Subtitle. Klik Insert Clip Are. Pilih gambar yang sesual.
Com dan paste.

Ulang langkah 5 untuk MORAL FEELING dan MORAL ACTION.

Ulangi langkah 5. Ketik' IT'S NOT HARD TO MAKE DECISIONS
WHEN YOU KNOW WHAT YOUR VALUES ARE (Rov Disney) pada
Click 1o Add Subtitle. Blok Rov Disnev, lalu klik ot Color. Pilith warna

kuning.
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11.  Ulang langkah 5. Ketiklah: TERIMA KASIH, SELAMAT BELAJAR,
SUKSES UNTUK ANDA di bagian (Tick to Add Subuitic. Aktifkan Insert
Picture. Pilthlah foto Sunset.jpg. Copylah foto tersebut dan klik paste pada

bagtan Click 1 Add Subtitle.

D. PENUGASAN
1. Buatlah Kerangka Slide dari bidang studi yang Anda ajarkan dengan
susunan: pembukaan, isi, dan penutup.
2. Buatlah 1 rsatu) Kerangka Konsep (Peta Konsep) dar pokok bahasan
vang Amda ajarkan di semester ini dalam slide menggunakan program

Microsopt PowerPoint,
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Lampiran Lembas Kerja:

LEMBAR KERJA
MEMBUAT SLIDE PEMBELAJARAN

MENGGUNAKAN PROGRAM MICROSOFT POWERPOINT
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Lampiran:

Lembar Kerja Membuat Slide Pembelajaran
Menggunakan Microsoft PowerPoint

SELAMAT DATANG

MATA PELAJARAN :

BUDIREKERT

NAMA GURU :

Drs. Eddy Purwanto

3 CORPONEANS

ClRACTER

66
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Lampiran:

Lembar Kerja Membuat Slide Pembelajaran
Menggunakan Microsoft PowerPoint

3 COMPONENT

GOOD CHARACTER

Voo Y

MORAL KNOWING

MORAL ACTION /

MORAL KNOWING

® Tahu nilai-nilai moral

B

@ Tahu alasan moral :

® Tahu manfaat moral @

MORAL FEELING

s EMPATI

m  KESADARAN DIRI ‘i

s PENGHARGAAN DIRI

67
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Lampiran:

Lembar Kerja Membuat Slide Pembelajaran
Menggunakan Microsoft PowerPoint

MORAL ACTION

mKompetensi

mKemauan

aKebiasaan

IT’S NOT HARD
TO MAKE DECISIONS

WHEN YOU KNOW WHAT

YOUR VALUES ARE

(Roy Disney)

TERIMA KASIH
SELAMAT BELAJAR

SUKSES UNTUK ANDA

68
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NAMA GURU e
BIDANG STUDI e
NILAI e

PRETEST / POSTTEST*

MATERI - MICROSOFT POWERPOINT
WAKTU : 20 MENIT

Petunjuk mengerjakan:

Bapak/ bu dipersilakan memilth jawaban yang menurut Bapak/ Ibu paling
benar dengan melingkari huruf di depan alternatif jawaban.

Quick Launch

B‘QE--

1 2 3 4 5

I. Dar kelima gambar icon di atas, pilihlah gambar icon nomor berapa yang
sebagai icon Microsoft Power Point

a |1
b. 2
¢c. 3
d 4
e 35
" ) =¥ 9]
Emmmmwwnmwmx
- -reT L T ET . TpetSepe -7
Anal -19-91:@l£ﬁ,-l§!m’:

N i kA LA

o o e
1= A= )
[re Py T T R D T RV
IEW SR OCAHAQEE DA 7= »
el 1 Dol asigr Engheh (U.5) o

2. Agar muncul tayangan seperti di atas, maka perintah yang digunakan ...
Microsoft Power Point > Program > Start
Start > Microsoft Power Point > Program
Microsoft Power Point > Start > Program
Start > Program > Microsoft Power Point
Program > Start > Microsoft Power Point

o a6 o
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3. Agar muncul pilihan slide di sebelah kanan pada gambar di atas, maka
perintah yang digunakan ...

Fiew > Master > Slide Master

Fiew > Slide Master > Master

Slide Master > Master > Fiew

Slide Master > Fiew > Master

Master > Fiew > Shide Master

o0 o
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4. Untuk menambah slide baru, maka perintah yang digunakan ...
New Slide Master > Insert

New Slide Master

Insert

Insert > New Slide Master

Insert < New Siide Master

a.
b.
c.
d
€.
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Led Lok
{

3. Agar muncul pilihan gambar/ foto yang tersimpan di file komputer
(tampak icon file di atas), maka perintah yang digunakan ...

From File > Insert > Picture

From File > Picture > Insert

Picture > From File > Insert

Insert > From File > Picture

Insert > Picture > From File

o po o

Word A Cothery

. B
”&E&WMW wor e 1" M -
| 4

}if{‘.-'."a'..‘."" “.UI'LL"\H Wrrdist .u";.’j;.:ii“
W iy
‘ w wardan | Worcart VTG A

[Werdne fardare | arddet ol || &
e [ [ [ |
[T ] cacni |

& Agar muncul pilihan huruf di atas, maka perintah yang digunakan ...
Insert > WordArt > Picture

Insert > Picture > WordArt

WordArt > Picture > From File

Picture > WordArt > Insert

WordArt > Insert > Picture

ceo o

TEeeest Posttest Guru PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO




72
IR-PERPUSTAKAAN UNIVERSITAS AIRLANGGA

Diagram Gallery

Select a diagram type;

sk (|| <3 ||| S&
0—’9\—0
OJ o’ 1

QOrganization Chart
Used to show hierarchical relationships

| QK I Cancel I

270

&2
©

7. Agar muncul pilihan diagram di1 atas, maka perintah yang digunakan ...
Insert

Diagram

Insert > Diagram

Diagram > [nsert

[nsert < Diagram

Diagram > Insert > Art

oo o

B Ariel Black

B el Norrow 24~
B AvantGarde Bk BT <8 _'j
T AvantGarde Md BT | 2
_m i Color:
: 1 Underine [ Superscript i I
17 Shadow offset:|o 4% |
I Emboss ™ subscript ! W feta foe npvs chizes

Th'sisaTnneTvpeFut..
This same Fort will be used on both your printer and your scresn,

8. Agar muncul pilihan jenis huruf di atas, maka perintah yang digunakan ...
Font

Format

Font > Format

Format > Font

Format > Font > Set

a.
b.
c.
d.
€.
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Falicbw ol ~enbir g
1 1) | -
Mane 2 ' 2 I
3 3) [
A, a) a I
8. ' by ' b i
3] . mn.
| [ ) 5 Lo II. E
- [— ]
i | o | _coen |

9 Agar muncul pilihan jenis nomor depan, maka perintan yang digunakan ...
Format

Bullets and Numbering

Format > Bullets and Numbering

Bullets and Numbering > Format

Format > Numbering

o6 o

B0 B B e e ke BRElee W b
- o TS Eu
ue s iR sfERE - KA v

Chck to add title

ST akt b

BT 3
o . ol D A BT Wb S BT kel
L Lol vy ry—
tor! R FANENG 2 . {a oun
I fijame st e {R§w 1 —

10. Agar muncul pilihan jems desain, maka perintah yang digunakan ...
Format

Slide Design

Format > Slide Design

Slide Design > Format

Format > Design

o as o
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Elme W e e rwed D e e
[ (3 ToSBU By k- - - AT W
- Sr-wd3aEER A G e e

Choh to ackd the

TAratepait Lt0,
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Cer At

[ L El

e[ s T WA EDR T A M EB, Dt s o L omA Y w.
-y mbdrbumy L ]
ool DR IABERY 2 i ew
i onnn J B bt ey vt [ - " -

11. Agar muncul pihihan jenis layout (pengaturan tulisan dan gambar), maka

perintah yang digunakan ...
a. Format

b. Slide Lavout

¢. Format > Slide Layout
d. Slide Layout > Format
¢. Format > Layout

F] e B e e el WpRee pw

8 R LN XN T T R R

BRIV BEN T LI e Gfowes e

FELATIHAN

ORIENTAS)
PRAKTKLU
EvALLIAZI

e . L
m.-_[{i_]“- sl A A A-ES Ry B g,

L IL Ll ey )

sl AR CDERBAY 2
- g Pyt el [[ P et PmaarPodel

[T
e

12. Agar muncul pilihan warna desain, maka perintah yang digunakan ...

oo o

Slide Design

Color Scemes

Format > Slide Design > Color Scemes
Color Scemes > Shide Design

Design > Color
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PELATIHAN

+ PENGANTAR

+ PENYAJIAN TEORI

« PRAKTIKUM
ALUASH

e
e
i
p

-

i

13. Agar tayangan slide show di atas kembali normal, maka perintahnva ...

a. End Show

b. The End

¢. Finish

d. Close

¢. Program > Finish

14. Microsoft Power Point adalah program komputer yang secara khusus
disiapkan untuk keperluan...

menambah halaman pengetikan dengan gambar

pembuatan tayangan animasi

presentasi

pengolah data penulisan

penambahan citra tampilan

oo oR

15. Microsoft Power Point dapat menampilkan objek berikut mi secara lebih
menarik, kecuali objek berupa ...

gambar

suara

huruf

patung

foto

°po o

16. Tayangan Microsoft Power Point akan lebih menarik jika secara
proporsional menyertakan unsur pendukung yang biasanya disebut ...

ilusi

tlustrasi

transposisi

kisi-kisi

komposisi

a.
b.
c.
d.
€.
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17. Jika kita menghendaki agar tayangan tampil bagus dengan nuansa dingin
(sejuk), maka ...

warna biru lebih banyak daripada wama orange

wama biru sama banyaknya dengan wama orange

warna biru lebih sedikit daripada warna orange

warna hijau lebih sedikit daripada warna orange

warna hijau sama banyaknya dengan warna orange

oae o

18. Slide pada Microsoft Power Point dapat meningkatkan pemahaman
pemirsa jika ...

backgroundnya memiliki jenis gambar yang sedikit

huckgroundnya memiliki jenis gambar yang banyak

backgroundnya memiliki jenis gambar sedikit, jumlahnya banyak

backgroundnya memiliki jenis gambar banyak, warna banyak

backgroundnya memiliki jenis gambar banyak, warna sedikit

o oe o

19. Slide pada Microsoft Power Point efektf jika memuat ...

kalimat yang ditulis secara lengkap dan jelas

kalimat yang ditulis secara lengkap dan jelas disertai kata kunci
kata kunci yang ditulis secara tersendin

kata-kata bermakna yang disertai uraian penjelasan

kalimat dan kata-kata bermakna yang dirangkai sebagai kesimpulan

ocROo0oR

20. Tayangan slide pada Microsofi Power Point akan lebih menarik jika ada
unsur gerak saat ...

awal penayangan

pertengahan penayangan

akhir penayangan

awal dan tengah penayangan

tengah dan akhir penayangan

o oo o

21. Tayangan slide pada Microsoft Power Point akan lebih menank jika
disertai unsur suara yang ...

lebih rendah dari suara pembicara

sama dengan suara pembicara

lebih dominan dari suara pembicara

kadang dengan suara yang rendah kadang dengan suara yang tinggi

mencerminkan kepribadian pembicara dan pemirsa

o RO o

22. Agar tayangan bisa dilihat pemirsa yang jumlahnya banyak, maka
diperlukan alat yang biasa disebut LCD sebagai kepanjangan darti...
a. Light Compact Disc
b. Liquid Chyoda Disc
¢. Light Crystal Display
d. Liquid Chyodu Displuy
e. Liquid Crystal Display

SIS ) PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO
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[&] Microsaoft PowerPoint - [Presentationl]

AT

23. Untuk menuliskan suatu kata atau kalimat dalam silide terlebih dahulu
dapat menekan icon nomor ...

a. 1
b. 2
c. 7
d 8
e 12

24, Untuk membingkai secara bujur sangkar terhadap kata atau tulisan dalam
shde, tertebih dahulu dapat menekan icon nomor ...

4

5

6

9

10

o a0 o

25. Untuk membingkai secara bundar terhadap kata atau tulisan dalam slide,
terlebih dahulu dapat menekan icon nomor ...

3

6

8

11

12

a.
b.
c.
d.
e.
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Sasaran - Guru Peserta Pelatithan
Observer - Penelit:
Hari/ Tgl Lo o0 .2006
NO PERNYATAAN __ SKOR
' VARIABEL KEMAMPUAN GURL (X2) s } 31511 To
. PENGETAHUAN
O Peserta memahami permtah dalam membuat Ppresentas ] e ]
s Peserta mengetahui bentuk, ukuran dan warna huruf ‘
- dalam AMicrosoft PowerPoint L R
! 3 Peserta memahami bahwa Microsoft PowerPoint dapat | I ! :
digunakan dalam mendukung Proses Belajar Menga)ar N ~
i 4 Peserta memahami bagaimana memlai hasi! akhir :
pembuatan presentast. 3 . L_____
| 2. SIKAP
i 5 Peserta menerima nilai-nilai respect, ct, responsibility. B )
[ 6 Peserta bersedia menerapkan nilai-nilai.
: 7 Peserta mengkaitkan nilai-nilai respect, re\pnmfbthn
P _ dengan nilai-nilai enjoy.
3 Peserta menyusun seluruh nilai-nilai yany dimiliki i
menjadi satu kesatuan. |
9 Peserta menjadikan milai- nilai sebagai bagian dirinya
10 Peserta menerapkan m]al mla1 dalam pembuatan mediz i
3. KETRAMPILAN T
o Secara refleks peserta terbiasa menombol gambar disker ‘ -[
L agar hasil pekerjaan tersimpan dengan aman ; ! B
12 Peserta dapat mengetik dengan komputer. 1 } )
13 Peserta dapat membedakan beberapa suara untuk T |=
L melengkapi media presentast. ) S S SR R
14 Peserta dapat membedakan beberapa gambar untuk l ’. ’
melengkapi media presentast. ' : | 4
_ SRR S P —
15 Peserta membuat presentasi tidak selalu berurutan baik ' i i |
) huruf, gambar, dan suara I D e
P Peserta dapat membuat presentasi i dalam waktu singkat . ! ‘
dengan hasil vanyg bagus - 1 i
17 | Peserta dapat mengarahkan kursor gada icon vang dituiy l | * ! ;
18 Peserta trampii dalam menu:.mnakan kevhourd dan mowe ! ; i
| komputer secara bergantian. o i
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Keterangan:
| B
Angka | Keterangan :
L
4 ' Sangal Baik .
e gal ba |
.3 | Bak e

2 (Cukwp

1 Kurang, o
0 _ISangat Kurang .'
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LEMBAR OBSERVASI
Sasaran : Siswa peserta pembelajaran
Observer : Peneliti
Hari/ Tgl - B AP 2006
NO PERNYATAAN PILTHAN
VARIABEL PERHATIAN (1) 4|32t |0
Perhatan siswa lebih terfokus ketika presentasi
1 MPP menampilkan tulisan yang hurufnya
berwarna.
5 Perhatian siswa lebih terfokus ketika presentasi

MPP menampilkan gambar vang berwarna.
Perhatan siswa lebih terfokus ketika presentasi
MPP menampilkan tulisan yang susunan
hurufrya lain dari biasanya.

Perhatian siswa Iebih terfokus ketika presentasi
4 MPP menampilkan gambar yang susunannya
lain dari biasanya.

Perhatian siswa lebih terfokus ketika presentasi

[ ]

> MPP menampilkan tulisan yang bisa bergerak.

6 Perhatian siswa lebih terfokus ketika presentasi
MPP menampilkan gambar yang bisa bergerak.
Perhatian siswa lebih terfokus saat presentasi

7 MPP karena siswa senang dapat melihat tulisan

atau gambar/ itustrasi dengan background yang

berwarna warni.

Perhatan siswa lebih terfokus saat presentasi

8 MPP karena siswa senang dapat melihat tulisan

atau gambar yang bergerak.

Perhanan siswa lebih terfokus kepada presentasi

9 MPP karena siswa membutuhkan ilmu

pengetahuan dari suatu mata pelajaran.

Perhatian siswa lebih terfokus kepada presentasi

10 MPP karena untuk memenuhi kebutuhan rasa

ingin tahu siswa. N

Perhatian siswa lebih terfokus kepada presentasi

11 MPP agar nantinya memudahkan siswa dalam

mengerjakan tugas-fugas.

Perhatian siswa lebih terfokus kepada presentasi

2 MPP agar nantinya dapat mengerjakan soal-soal
! ulangan.
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Keterangan:
Angka Keterangan
|4 Sanpat Baik B
3 | Baik
2 C
1 . Kurang )
| 0 Sangat Kurang )

Catatan kejadian selama observasi berlangsung, sebagai berikut

PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO
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Lampiran : Penghitungan Puired ¢ Test Kemampuan Guru
TABEL PENGHITUNGAN PAIRED t TEST ANTARA KOGNITIF SEBELUM
PELATIHAN DAN SESUDAH PELATIHAN
SEBELUM SETELAH 2
NO | PELATIHAN [PELATIHAN[ O] ¢l 61-6 | (61-0)
01 02 (02-01)
1 9 15 6 36 0 0
2 9 14 5 25 -1 [
3 8 14 o 36 0 0
4 9 15 6 36 0 0
5 7 14 7 49 ] ]
6 9 14 5 25 -1 1
7 9 15 6 k14] 0 0
8 8 15 7 49 ] ]
9 8 L5 7 49 1 l
10 9 16 7 49 l I
= 85 | Z= 147 62 3%0) I = 6
X= 851Y= 14,7|0= 6 |[L= 39

(= 6 - 39
0.82 f 316
-33
t = —_—
0,26
t = -127,03
Lihat pada tabel.
df = 9
a - 0,05
t tabel = 2,132

t Hit < t Tabel, maka Ho Ditoiak
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TABEL PENGHITUNGAN PAIRED t TEST ANTARA AFEKTIF SEBELUM PELATIHAN
DAN SESUDAH PELATIHAN

SEBELUM SETELAH 2
NO PELATIHAN | PELATIHAN | ! ¢l 61-6 |(61 6)
o1 0?2 (02-01)
2 I3 20 7 49 = 4
3 13 19 6 36 A 9
y 9 19 10 100 1 I
6 12 20 8 64 -1 ]
g 9 I8 9 81 1] 0
0 i4 24 10 100 i l
Y= 118 = 204 86 754 = 17
X= 11,8] Y= 204{0= 9 |U= 75
{ = 61 - uol
SDal / +n

¢ - 9 - 735
1,37 / 3,16
-67
t = —
0.43
t = -1583,70
Lihat pada tabel.
df = 9
a = 0,05
t tabel = 2,132

t Hit < t Tabel, maka Ho Ditolak
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TABEL PENGHITUNGAN PAIRED t TEST ANTARA PSIKOMOTORIK SEBELUM
PELATIHAN DAN SESUDAH PELATIHAN

NO SEBELUM SETELAM 61 612
- — .2
PELATIHAN | PELATIHAN 6i-6{(61-0)
01 02 (02-01)
1 16 27 11 121 -1 1
2 16 30 14 196 2 4
3 18 30 12 144 0
4 16 28 12 144 0 0
5 18 28 10 100 2 4
6 13 28 13 169 ] 1
7 19 31 12 144 0 0
8 16 28 ' 12 144 0 0
9 15 28 13 169 i i
10 17 31 14 196 2 4
T= 166 [L= 289 123 1527 L= 15
X= 166 |Y= 289 (6= 12|IL= 153
{ = cl - Mol

12 - 153
1.29 / 316

{ = —140
041

t = -343,91
Lihat pada tabel.

df = 9

a= 0,05

t tabel = 2,132

t Hit < t Tabel, maka Ho Ditolak
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TABEL PENGHITUNGAN PAIRED t TEST ANTARA PBM SEBELUM MENGGUNAKAN
MICROSOFT POWERPOINT DAN PBM SETELAH MENGGUNAKAN MICROSOFT

POWERPOINT
SEBELUM SETELAH 61 — _
NO | PELATIHAN | PELATIHAN Gg1? 61-6 | (61-6 )2
{01) (02) (02 -01)
1 21 39 18 324 310 96.100
2 17 36 19 361 347 120.409
3 21 42 21 441 427 182.329
4 27 35 8 64 50 2.500
5 20 38 18 324 310 96.100
6 27 39 12 144 130 16.900
7 23 39 16 256 242 58.564
) 20 34 14 196 182 33.124
9 15 32 17 289 275 75625
10 23 37 14 196 182 33.124
11 17 36 19 361 347 120.409
12 22 36 14 196 182 33124
13 20 33 13 169 155 24 025
14 24 36 12 144 130 16.900
15 21 39 18 324 310 96.100
16 20 33 13 169 155 24.025
17 28 39 1 121 107 11.449
18 20 32 12 144 130 16.900
19 26 a4 18 324 310 96.100
20 21 45 24 576 562 315.844
21 25 41 16 256 242 58 564
22 23 39 16 256 242 58 564
23 22 37 15 225 211 44 521
24 24 35 1 121 107 11.449
i 25 24 38 14 196 182 33124
26 17 3] 14 196 182 33,124
27 20 38 (8 324 310 96.100
28 20 37 17 289 275 75.625
29 22 36 14 196 182 33.124
30 24 at 17 289 275 75.625
3] 24 38 14 196 182 33.124
32 26 36 10 100 86 7396
33 20 32 12 144 130 16.900
34 25 38 13 169 155 24.025
35 21 42 2 441 427 182329 [f
36 21 37 16 256 242 58 564
37 18 34 16 256 242 58 564
38 25 35 10 100 86 7.396
39 15 31 16 256 242 58 564
40 23 38 15 225 211 44.52]
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41 23 31 8 64 50 2 500
42 19 40 210 441 427 182329
43 22 44 22 - 484 470 220500
44 20 34 14 [96 182 33124
45 22 41 9 361 347 120 409
46 20 36 16 256 242 58564
47 26 42 16 256 242 58.564
48 23 42 9 361 347 120,409
49 28 43 i5 225 211 44 521
50 28 43 15 225 211 44 5210
51 30 7 17 289 275 75628
52 24 36 i2 144 i30 16,900
53 19 35 16 256 242 58 564
54 24 42 I8 324 310 96 100
55 31 41 10 100 R6 7.3596
56 25 38 13 169 155 24.025
57 34 44 10 100 86 7.396
58 26 42 16 256 242 58.564
59 25 32 T 19 35 1.225
60 25 37 12 144 130 16.900
61 23 44 21 441 427 182329
62 24 33 9 81 67 4 489
63 27 44 17 289 275 75625
64 26 4] 15 225 2H 44 52|
65 28 41 13 169 155 24.025
66 25 42 £7 289 275 75.625
67 25 36 11 121 107 I].44%
68 23 47 24 576 562 315844
69 28 39 11 121 107 11.449
70 25 38 13 169 55 24025
71 23 45 22 184 470 220904
72 22 39 17 289 275 75628
73 24 41 17 289 275 75625,
74 16 3z 16 256 242 58 564
75 24 45 2l 141 427 182329
76 23 43 20 400 386 148966
77 19 40 2] 441 427 182329
78 ig 35 i7 289 278 T5 625
79 24 41 17 289 275 75625
20 26 4! £S5 225 211 44 521
81 28 19 11 121 1Q7 [1 449
82 22 41 19 361 347 120409
B3 i9 35 16 256 242 S8 5nd
R4 25 42 17 289 275 75623
85 25 40 15 225 21 44 821
Bo 29 42 13 169 155 24 025
87 23 35 12 144 130 16,900
38 20 38 18 324 30 96,100
89 27 35 g 64 50 2.5(4)
90 26 43 17 289 275 F5.625
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91 25 39 14 196 182 33.124
92 26 35 9 81 67 4.489
93 24 35 11 - 121 107 11.449
94 28 38 10 100 86 7.396
95 28 42 i4 196 182 33.124
96 26 40 14 196 182 33.124
97 20 36 16 256 242 58.564
98 23 38 15 228 211 44.521
99 20 38 18 324 310 96.100
100 28 39 11 121 107 11.449
101 33 36 3 9 -5 28
102 27 38 1 121 107 [1.449
103 -8 44 16 256 242 58.564
104 32 40 8 64 50 2.500
105 23 33 10 100 86 7.396
106 22 35 13 169 155 24.025
107 23 42 17 289 275 75.625
108 19 34 15 225 21) 44.521
109 33 38 (5 228 211 44.521
110 25 38 13 169 155 24.025
111 9 43 14 196 182 33.124
112 27 a4 22 484 470 220,900
113 29 45 16 256 242 58.564
114 24 40 16 256 242 58.564
115 25 41 16 256 242 58.564
116 18 32 14 196 182 33.124
117 18 36 18 324 310 96.100
118 22 34 12 144 130 16.900
119 26 42 16 256 242 58.564
120 24 43 19 361 347 120.409
121 8 38 10 100 86 7.396
122 27 43 16 256 242 58.564
123 20 35 15 225 211 44,521
124 2 42 20 400 386 148 996
125 23 37 14 196 182 33.124
126 28 36 11 121 107 11.449
127 ] 42 18 324 310 96.100
128 27 40 13 169 155 24,025
129 20 33 13 169 155 24.025
130 {7 34 17 289 275 75 625
131 24 39 15 22% 211 44,521
132 2 32 11 12 107 11.449
133 24 33 11 121 107 11.449
134 2 37 15 228 211 44 521
135 14 34 20 400 386 148.996
136 iR 33 11 121 107 11.449
137 2 39 13 169 155 24.025
138 23 37 14 196 182 33,124
139 22 35 13 169 155 24.025
140 23 37 12 144 130 16 900
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141 15 34 19 361 347 120,409
142 25 41 16 256 242 58.564
143 23 37 14 - 196 182 33.124
144 26 17 11 121 107 11.449
145 15 40 25 625 23 373.321
146 24 41 17 289 275 75.625
147 30 44 14 196 182 33.124
148 19 34 15 225 211 44.521
149 23 40 17 289 275 73.625
150 24 34 10 100 86 7.396
151 22 42 20 400 386 148 996
152 26 39 13 169 155 24.025
153 17 34 17 239 275 75.625
154 23 41 18 324 310 96.100
155 24 42 18 324 310 96.100
156 26 39 13 169 155 24.025
157 27 40 13 169 155 24025
158 27 41 14 196 182 33.124
159 18 33 15 225 211 44.521
160 24 39 15 225 211 44521
161 27 44 17 289 275 75.625
162 20 34 14 196 182 33.124
163 21 34 13 169 155 24.025
164 25 29 4 16 2 4
165 26 38 12 144 130 16.900
166 22 37 15 225 211 44 521
167 27 37 10 100 B6 7396
168 22 34 12 144 130 16.900
169 26 37 11 121 107 11.449
170 30 40 10 100 86 7.396
171 25 36 tH 121 107 11.449
172 18 34 16 256 242 58.564
173 26 39 I3 169 155 24.025
174 26 35 9 81 67 4.489
175 22 36 14 196 182 33.124
176 28 40 12 144 130 16500
177 29 39 10 100 86 7.396
178 22 36 14 166 182 33124
179 30 4] 11 121 107 11.449
180 25 35 10 L00 86 7.396
18] 25 38 13 169 155 24025
182 27 42 15 225 211 44 521
83 27 37 10 100 86 7396
134 23 41 18 324 310 96.100
i85 25 42 17 289 275 75.625
186 22 42 20 400 386 148 996
187 29 38 9 81 67 4.489
188 30 16 6 36 22 184
189 28 39 11 121 107 11 449
190 22 36 14 196 182 33.124
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191 25 35 10 100 BG 7 396
192 25 41 16 256 242 58.564
193 24 40 16 256 242 58.564
194 29 42 13 169 155 24.025
195 24 16 12 144 130 16.900
196 23 37 14 196 182 33.124
197 25 38 13 169 155 24.0235
198 26 42 i6 156 242 58 564
199 28 36 8 64 50 2.500
200 27 38 11 121 107 11.449
201 19 38 19 361 347 120.409
202 27 i3 I 21 107 11.449
203 20 34 14 196 182 33.124
204 23 38 15 225 211 44.521
205 3l 41 10 100 86 1.396
206 1% 34 15 225 211 44.521
207 25 39 14 196 182 33.124
208 21 37 16 256 242 58.564
209 28 39 il 121 107 11.449
210 21 35 14 196 182 33.124
211 25 36 11 121 167 11.449
212 30 40 10 100 86 7.396
213 Mo Lo 7y s s 1.225
214 24 i3 0 3o 22 84
)% 20 L L 2 0 96,100
216 23 40 17 289 275 75.625
217 24 39 15 225 211 44.52!
218 25 38 13 169 155 24.025
219 24 38 14 196 182 33.124
220 27 37 10 100 86 7.396
22) 21 41 20 400 136 148.996
222 22 32 10 100 86 7.396
223 28 39 ¥ 121 107 11.449
224 30 19 9 81 67 4.489
225 22 42 20 400 186 148.996
226 28 36 8 64 50 2.500
227 22 37 15 225 211 44.521
228 25 33 13 169 153 24.025
229 29 44 15 225 211 44,521
130 11 43 24 el 417 TH2 429
23 24 38 1] 121 Wi [ 449
232 29 46 17 289 275 75.625
233 28 45 17 289 275 75.625
234 21 38 16 156 242 58.564
235 23 40 17 289 275 73.625
236 29 39 10 100 86 7.396
237 19 35 16 256 242 58.564
238 30 33 3 2 -5 15
239 25 31 6 36 22 484
240 25 4] 16 256 242 58.564
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241 24 38 14 196 182 33.124
242 24 41 17 289 275 75625
243 26 36 10 100 86 7.396
244 26 30 10 100 86 7. 396
245 24 335 i1 i2l 107 11.449
246 26 43 17 289 275 75.625
247 20 34 14 196 182 33124
248 28 16 8 64 S0 2.500
2449 25 I8 13 [ 155 24 025
250 20 35 15 225 211 44521
351 21 34 I3 169 155 24,025
252 23 33 10 100 86 7.366
25} 20 40 2D 400 80 148 9940
254 23 43 20 400 386 148.996
255 25 37 12 144 130 16900
256 19 31 12 144 130 16.900
257 23 41 I8 324 310 96,100
258 21 38 17 289 275 75625
159 28 39 11 121 107 11.449
260 17 36 19 361 347 120.409
261 24 36 12 144 130 16.900
262 23 39 16 256 242 58 564
T= 6255 | L= 9989 3734 56894 = | 13.868.166
X= 23874| Y= 381[6= 4 [L- 2i7
{ ol - po)
SDol / ~n
[ = 14 - 217
230,51 /1619
t = -203
14,24
t = -14,25
Lihat pada tabel
df = 261
a= 005

ttabel = 1,045

t Hit < t Tabel, maka Ho Ditolak
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[.ampiran; Analisis terhadap Aspek Perhatian Siswa.

1. Hasil Pentlaian Siswa terhadap Aspek Perhatian (Versi /'ricdman Test).

1.1. Penilaian Siswa terhadap Empat Aspek Objek Perhatian.

Tabel 5.3 Ranks

Mean Rank
W 2,34
GW 2,54
TG 2862
GG 2.50

Tabel 5.4 Test Statiftics

N 262
Chi-Sguare 11,728
df 3

Asymp. Sig. 008

a. Friedman Test

1.2 Penilinan Siswa terhadap mpat Aspek Subyek Peratian

Tabel 5.5 Ranks
Mean Rank
Sw 2,64
5G 2,45
Bi 2,51
T 2,40

Tabel 5.6 Test Statidtics

N 262
Chi-Square 7,007
df 3
Asymp. Sig. 072

a. Friedman Test
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2. Hasil Kesepakatan Siswa terhadap Aspek Perhatian

(Versi Kendall's W Test),

Tabel 5.17 Ranks

Mean Rank
TW 4 35
GW 4,75
TG 492
GG 466
2 4,64
8G 422
B! 4,35
TT 411

Tabel 5.18 Test Statistics

N 262
Kendall's W32 018
Chi-Square 33,678
df 7
Asymp Sig 000

a. Kendall's Coefficient of Concordance
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